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INBIT LICENSE AGREEMENT 
 
SOFTWARE PRODUCT: FULLSHOT 9 FOR WINDOWS 
 
IMPORTANT - READ CAREFULLY: THIS INBIT END-USER LICENSE AGREEMENT IS A LEGAL AGREEMENT 
BETWEEN YOU AND INBIT INCORPORATED FOR THE INBIT SOFTWARE PRODUCT IDENTIFIED ABOVE, WHICH 
INCLUDES COMPUTER SOFTWARE AND RELATED DOCUMENTATION. BY INSTALLING, COPYING OR OTHERWISE 
USING THE SOFTWARE PRODUCT, YOU AGREE TO BE BOUND BY THE TERMS AND CONDITIONS OF THIS 
AGREEMENT. IF YOU DO NOT AGREE TO THESE TERMS, YOU SHOULD RETURN THE UNUSED PRODUCT, 
INCLUDING THE PACKAGING AND ALL WRITTEN MATERIALS, TO THE PLACE OF PURCHASE PROMPTLY FOR A 
FULL REFUND. 
 
1.  GRANT OF LICENSE.  This Agreement grants to you the right to use one copy of the SOFTWARE PRODUCT 
on a single computer. You may load one copy into permanent memory of one computer and may use that copy only on 
that same computer. You may not install the software on a network server unless you purchase an appropriate license. 
 
2.  COPYRIGHT.  The SOFTWARE PRODUCT and accompanying written materials are owned by Inbit 
Incorporated and is protected by copyright laws of the United States, by laws of other nations, and by international 
copyright treaties. The SOFTWARE PRODUCT is licensed, not sold. 
 
3.  RESTRICTIONS ON USE AND TRANSFER.  You may not copy the SOFTWARE PRODUCT, except that (1) 
you may make one copy of the SOFTWARE PRODUCT solely for backup or archival purposes, and (2) you may 
transfer the SOFTWARE PRODUCT to a single hard disk provided you keep the original solely for backup or archival 
purposes. You may not copy the written materials. You may permanently transfer the SOFTWARE PRODUCT and 
accompanying written materials (including the most recent update and all prior versions) if you retain no copies and the 
transferee agrees to be bound by the terms of this Agreement. Such a transfer terminates your license. You may not rent 
or lease the SOFTWARE PRODUCT or otherwise transfer or assign the right to use the SOFTWARE PRODUCT, 
except as stated in this paragraph. 
 
4.  LIMITED WARRANTY.  Inbit warrants that the SOFTWARE PRODUCT will perform substantially in 
accordance with the accompanying written materials for a period of 60 days from the date of your receipt of the 
SOFTWARE PRODUCT. Any implied warranties on the SOFTWARE PRODUCT are limited to 60 days. 
 
5.  NO OTHER WARRANTIES.  INBIT DISCLAIMS ALL OTHER WARRANTIES, EITHER EXPRESS OR IMPLIED, 
INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR 
PURPOSE, WITH RESPECT TO THE SOFTWARE PRODUCT AND THE ACCOMPANYING WRITTEN MATERIALS. 
 
6.  CUSTOMER REMEDIES.  INBIT'S ENTIRE LIABILITY AND YOUR EXCLUSIVE REMEDY SHALL BE, AT INBIT'S 
CHOICE, EITHER (A) RETURN OF THE PRICE PAID OR (B) REPLACEMENT OF THE SOFTWARE PRODUCT THAT DOES 
NOT MEET INBIT'S LIMITED WARRANTY AND WHICH IS RETURNED TO INBIT WITH A COPY OF YOUR RECEIPT. 
Any replacement SOFTWARE PRODUCT will be warranted for the remainder of the original warranty period or 60 
days, whichever is longer. These remedies are not available outside the United States of America. 
 
7.  NO LIABILITY FOR CONSEQUENTIAL DAMAGES.  IN NO EVENT WILL INBIT BE LIABLE TO YOU FOR 
DAMAGES, INCLUDING ANY LOSS OF PROFITS, LOST SAVINGS, OR OTHER INCIDENTAL OR CONSEQUENTIAL 
DAMAGES ARISING OUT OF YOUR USE OR INABILITY TO USE THE SOFTWARE PRODUCT. 
 
8.  U.S. GOVERNMENT RESTRICTED RIGHTS.  The SOFTWARE PRODUCT and documentation are provided 
with RESTRICTED RIGHTS. Use, duplication, or disclosure by the Government is subject to restrictions set forth in 
subparagraph (c)(1) of The Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 or 
subparagraphs (c)(1)(ii) and (2) of Commercial Computer Software - Restricted Rights at 48 CFR 52.227-19, as 
applicable. Manufacturer is Inbit Incorporated. 
 
If you acquired this SOFTWARE PRODUCT in the United States, this Agreement is governed by the laws of the State 
of California. If you have any questions concerning this Agreement or wish to contact Inbit for any reason, please 
write: Inbit Inc, P.O.Box 391674, Mountain View, CA 94039, USA. 
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Chapter 1. Introduction 

1.1 Welcome 
 

Welcome to FullShot! 
 
FullShot is the complete image capture, annotation, image database and screen printing program designed 
for users who need to work with images from any application running on Microsoft Windows. 
 

1.2 System Requirements 
 
FullShot is a 32-bit Windows application. It requires one of the following Windows operating systems on 
your PC: 
 
Windows 98 
Windows 98 SE 
Windows Me (Millennium Edition) 
Windows 2000 (Workstation or Server) 
Windows XP (Home Edition or Professional Edition) 
Windows Server 2003 
 
If you don't have any of the above Windows installed, you need to upgrade your system software before 
installing FullShot. 
 
The total hard drive space needed is 20MB. The total memory requirement is 128MB. The more memory 
you have, however, the smoother FullShot will run. 
 

1.3 What FullShot Can Do for You 
 
Capturing images 
 

 Capture images in more than 100 capture type combinations: screen capture, window capture, object 
capture, region capture, title & menu capture, freehand capture, mouse pointer capture, button capture, 
command bar capture, auto-scroll document capture, interactive scroll capture and session capture. 

 Capture images by using on-screen Snapshot Buttons or Hotkeys. 
 Capture images in 4-bit (16 colors), 8-bit (256 colors), 15-bit (32K colors), 16-bit (64K colors), 24-bit 

(16.8M colors), 32-bit color modes, as well as in black-and-white mode. 
 Capture images in 640x480, 800x600, 1024x768, 1152x864, 1280x1024, 1600x1200 and even higher 

resolution. 
 Capture a complete screen or separate objects on the screen such as dialog boxes, menus, list controls, 

tree controls, command buttons, radio buttons, check boxes, toolbars, and mouse pointers. 
 Capture any rectangular or freely drawn region of a screen you define using a mouse. 
 Capture images in continuous sessions. 

 
Adding special effects to images 
 

 Add drop-shadow effects to an image in any angle, distance and size during capture or after capture. 
 Add stroke effects to an image during capture or after capture. 
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 Add tear effects to an image during capture or after capture. 
 Add glare effects to an image during capture or after capture. 

 
Annotating images 
 

 Draw lines. 
 Draw rectangles and rounded rectangles. 
 Draw circles and ellipses. 
 Write text into images. 
 Draw 18 styles of callout. 
 Mark images with labeling tools. 

 
Printing images 
 

 Print images on any printer that Windows supports automatically or manually. 
 Print images with text annotations in multiple formats. 
 Print images with a header and footer. 
 Print images in any size. 
 Print images in multiple alignments and orientations. 
 Print multiple images on one page. 

 
Viewing and Converting Images 
 
FullShot is a perfect image viewer for the following popular image formats: FSD, BMP, CUR, DIB, EPS, 
GIF, ICO, JPE, JPG, JPEG, PCD, PCT, PCX, PNG, PSD, RAS, RLE, TGA, TIF, WMF, and WPG.  
FullShot can also read and display HTML pages. 
 
FullShot can convert images among supported image formats. 
 
Editing images 
 

 Add frames around images. 
 Resize images. 
 Flip or rotate images. 
 Translate color images to grayscale. 
 Reduce image colors to produce smaller files. 
 Crop images to a smaller size. 
 Blur part of an image. 
 Highlight part of an image. 
 Merge two or more images into one. 
 Change image resolution. 

 
Building an Image Database 
 

 Build an image database automatically or manually. 
 Support six indexes to search an image database. 
 Support the point-and-click intuitive search method. 
 Support the type-to-locate search method. 
 Support built-in backup procedures. 
 No programming is required. 
 View an image database sequentially in the thumbnail mode. 
 Intuitive data tips can bring up record information quickly. 

 
Email 
 

 Email image from a FullShot image window. 
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 Email image from a FullShot image database record. 
 Build contact database. 
 Track sent messages. 

 

1.4 FullShot Editions 
FullShot is released in three editions: Standard Edition, Professional Edition and Enterprise Edition. See the 
features list for comparison. 

 
 Standard 

Edition 
Professional 

Edition 
Enterprise 

Edition 
Multiple Monitor Support ♦ ♦ ♦ 
Supported Formats    
BMP ♦ ♦ ♦ 
CUR ♦ ♦ ♦ 
DIB ♦ ♦ ♦ 
EPS ♦ ♦ ♦ 
GIF ♦ ♦ ♦ 
ICO ♦ ♦ ♦ 
JPG, JPE, JPEG ♦ ♦ ♦ 
PCD ♦ ♦ ♦ 
PCT ♦ ♦ ♦ 
PCX ♦ ♦ ♦ 
PNG ♦ ♦ ♦ 
PSD ♦ ♦ ♦ 
RAS ♦ ♦ ♦ 
RLE ♦ ♦ ♦ 
TGA ♦ ♦ ♦ 
TIF ♦ ♦ ♦ 
WMF ♦ ♦ ♦ 
WPG ♦ ♦ ♦ 
FSD (FullShot Document) ♦ ♦ ♦ 
Pre-save File Size Comparison  ♦ ♦ 
Image Annotations    
Drawing ♦ ♦ ♦ 
Text ♦ ♦ ♦ 
Callout  ♦ ♦ 
Labeling  ♦ ♦ 
Capture Modes    
Screen Capture ♦ ♦ ♦ 
Window Capture ♦ ♦ ♦ 
Object Capture ♦ ♦ ♦ 
Region Capture (Rectangle, Ellipse) ♦ ♦ ♦ 
Title & Menu Capture ♦ ♦ ♦ 
Freehand Capture ♦ ♦ ♦ 
Pointer Capture  ♦ ♦ 
Button Capture  ♦ ♦ 
Command Bar Capture  ♦ ♦ 
Auto-Scroll Document Capture  ♦ ♦ 
Interactive Scroll Capture (Vertical and 

Horizontal) 
 ♦ ♦ 

Timer Controlled Session Capture  ♦ ♦ 
Image Resolution Settings  ♦ ♦ 
Special Effects    
Drop Shadow Effect ♦ ♦ ♦ 
Stroke Effect ♦ ♦ ♦ 
4-way Tear Effect ♦ ♦ ♦ 
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Glare Effect ♦ ♦ ♦ 
Viewers    
Still Image Viewer ♦ ♦ ♦ 
Animated GIF Viewer ♦ ♦ ♦ 
Thumbnail Viewer  ♦ ♦ 
HTML Viewer   ♦ 
Tools    
On Screen Capture Ruler ♦ ♦ ♦ 
Resize ♦ ♦ ♦ 
Flip ♦ ♦ ♦ 
Rotate ♦ ♦ ♦ 
Crop ♦ ♦ ♦ 
Blur ♦ ♦ ♦ 
Highlight ♦ ♦ ♦ 
Eraser ♦ ♦ ♦ 
Merge ♦ ♦ ♦ 
Printing    
Print Image ♦ ♦ ♦ 
Print Multiple Images ♦ ♦ ♦ 
Print All Images on One Page ♦ ♦ ♦ 
Print Image Database Record   ♦ 
Print HTML Page   ♦ 
Image Utilities    
ImageExplorer  ♦ ♦ 
BatchConvert  ♦ ♦ 
FullShot Image Database    
Database Read Only  ♦ ♦ 
Database Creation   ♦ 
Database Backup   ♦ 
Master Keyword Table   ♦ 
ID Index   ♦ 
Subject Index   ♦ 
Title Index   ♦ 
Keyword Index   ♦ 
Create Index   ♦ 
Update Index   ♦ 
Client/Server Support   ♦ 
Email    
Send Image from Image Window   ♦ 
Send Image From Image Database   ♦ 
Email Tracking   ♦ 
Contact Database   ♦ 
Export to Flash   ♦ 

 

1.5 Installing FullShot 
 
1. Start Windows. 
 Close all running applications. 
 
2. Insert the FullShot CD into your CD-ROM drive. 
 
3. If the Setup program doesn't get loaded automatically,  
 click the Start button, 
 choose the Run command, 
 type d:\setup and then click OK. 
 If the CD-ROM is not on D: drive, use the other drive letter. 
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If you received FullShot from one of the Inbit download sites, follow instructions on the web site to 
install FullShot. 

 
4. Follow the on-screen instructions to install FullShot. 
 

1.6 Registering FullShot 
After you install FullShot, send in the registration card enclosed with your copy of the program. You can 
also register your license at www.inbit.com/register.html. 
 
Registration entitles you to free technical support via email and information about future updates. If you 
have purchased support packages and need to call technical support, be ready to give the support engineer 
your license key, which appears on the FullShot CD jewel case or CD jacket. You can also find your 
license key in the About FullShot dialog box. 
 

1.7 Starting FullShot 
The FullShot icon should already be on your desktop window when the installation is completed. Double-
click on the icon to start FullShot. 
 

 
 
If you have already deleted the FullShot icon: 
 
1. Click the Start button. 
2. Choose the All Programs item. 
3. Choose the FullShot 9 submenu. 
4. Choose the FullShot 9 application. 
 

1.8 Uninstalling FullShot 
 
To uninstall FullShot: 

 

1. Click the Start button. 
2. Choose the All Programs item. 
3. Choose FullShot 9 submenu. 
4. Choose Uninstall FullShot 9. 
 

 

1.9 Technical Support 
Technical support via email is free. Contact support@inbit.com if you have any questions. For other 
support options, visit www.inbit.com for information about support packages. 
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Chapter 2. FullShot Basics 

2.1 FullShot Window 
 
The main FullShot window is a workspace where you can view and work on captured or imported images. 
It can contain more than one image at a time, each in a separate window. 
 

 
 

2.2 Snapshot Buttons 
 
The easiest way to capture images is with Snapshot Buttons. Clicking one of the buttons carries out the 
corresponding type of capture. 
 

 
 

 = Screen Capture 
 = Window Capture 
 = Object Capture 
 = Region Capture 
 =  Freehand Capture 

 
Available in the Professional Edition and Enterprise Edition: 
 

 = Button Capture 
 = Command Bar Capture 
 = Document Auto-Scroll Capture 
 = Interactive Scroll Capture 
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By default, SWOR buttons are turned on in the Standard Edition; SWORD buttons are selected in the 
Professional Edition and the Enterprise Edition. 
 
The Snapshot Buttons will be displayed on the title bar of the top most application window. 
 

2.3 On-Screen Capture Ruler 
FullShot can display an on-screen capture ruler that can help you see how large a window capture will be 
before you launch a capture against a window. If your documentation work has a limitation on an image 
size, knowing how large your target is can be a big help. Otherwise, you would have to perform several 
trial shots in order to find out which one may fit the space available. 
 
To turn on the on-screen Capture Ruler: 
 
1. Pull down the View menu. 
2. Choose the Capture Ruler command. 
 

 
 
Using the same command again will turn off the capture ruler. 
 
The on-screen ruler is a self-managed intelligent tool. When you drag a window frame to change the 
window size, it follows your drag and reports the new size on the ruler. It will auto hide itself if you don’t 
touch your target window for a while. 
 
The ruler can display three types of measurements: pixel, inch and centimeter. By default, it displays a 
window size in pixel mode. Right click the ruler to change the measurement to inch mode; right click again 
to change it to centimeter mode. 
 
The left image below shows the ruler in the pixel mode; the right image shows in the inch mode. 
 

   
 



 13

2.4 Toolbars 
There are four toolbars in the Standard Edition and the Professional Edition and one additional toolbar in 
the Enterprise Edition. 
 
Basic Toolbar:  
 

 
 
Capture Effects Toolbar: 
 

 
 
Annotation Toolbar: 
 

 
 
View & Editing Toolbar: 
 

 
 
Enterprise Toolbar: 
 

 
 
To know the name of a particular button, stop the mouse pointer over it. FullShot will display the name 
shortly. The basic toolbar has the following command buttons: 
 

 New command. Use this command to create an empty image. 

 Open Image command. Use this command to open an image file. You can also use the FullShot 
Explorer to open image files. 

 Save Image command. Use this command to save an image to a file. You can also use drag & drop 
method to drag an image to a folder in the FullShot Explorer. 

 Print command. Use this command to print the active image. 

 Copy Image command. Use this command to copy the active image to the Clipboard. 

 Paste Image command. Use this command to paste an image from the Clipboard to the FullShot 
window. 

 FullShot Explorer command. Use this command to turn on/off the FullShot Explorer. 

 Normal Pixel Size command. Use this command to view the active image in its original pixel size. 

 Fit to Window command. Use this command to view the active image by using the entire window 
space. 

 Full Screen View command. Use this command to view the active image in the full screen mode. 

 Flip Horizontal command. Use this command to flip the active image horizontally. 

 Flip Vertical command. Use this command to flip the active image vertically. 
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 Rotate Right command. Use this command to rotate the active image to the right. 

 Rotate Left command. Use this command to rotate the active image to the left. 

 Capture to FullShot Window option. Turn on/off Capture to FullShot Window mode. 

 Capture to Printer option. Turn on/off Capture to Printer mode. 

 Capture to Clipboard option. Turn on/off Capture to Clipboard mode. 

 Capture to File option. Turn on/off Capture to File mode. 

 Close All command. Use this command to close all of the open windows. 

 Folder Thumbnail View command. View all of the supported images in a folder, available in 
Professional Edition and Enterprise Edition. 

 Launch BatchCon, available in Professional Edition and Enterprise Edition. 

 Launch ImageExplorer, available in Professional Edition and Enterprise Edition. 

 Click Summary Report button to display ImageExplorer statistics, available in Professional 
Edition and Enterprise Edition. 

 
The capture effects toolbar has the following commands: 
 

 Drop Shadow Effect command. 

 Stroke Effect command. 

 Tear Effect command. 

 Glare Effect command. 

 Restore Default. Use this command to reset all capture effects settings. 
 
The view and editing toolbar, docked on the left frame by default, has the following commands: 
 

 Hand mode. This is not a command, and is a mode instead. In this mode, you can move the image 
up and down to see it and you can drag-and-drop to save the active image. 

 Object Selection and Movement mode. In this mode, you can select and then move an object 
within the canvas. 

 Group Selection mode. Press this button before select a group of objects. 

 Crop command. Use this command to trim unwanted edges. 

 Blur command. Use this command to blur a select area on the active image. 

 Highlight command. Use this command to highlight a selected area on the active image. 

 Eraser command. Use this command to erase a selected area on the active image. 

 Color Checker command. Use this command to check a pixel’s RGB value. 

 Zoom In command. Use this command to view the active image in a larger size. 

 Zoom Out command. Use this command to view the active image in a smaller size. 
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 Undo command. Use this command to undo an image editing and annotation action. 

 Redo command. Use this command to revert the previous undo. 
 
The annotation toolbar is featured in Chapter 9. The enterprise toolbar that hosts FullShot Image Database 
and Email command buttons is featured in Chapter 12 and Chapter 18. 
 

2.5 FullShot Explorer 
 
The FullShot Explorer lets you open, save and delete images in an easy way. It also allows users to open 
annotation files and databases. You can dock FullShot Explorer on any side of the FullShot window. To 
save precious screen space, you can enable Auto-Hide so that FullShot Explorer will hide itself when you 
click any image you’re working on. 
 

 
 
FullShot uses three file icons in the FullShot Explorer: 
 

 Color bar icon represents an image file in one of the supported formats.  
 Annotation icon represents a FSD file (saved annotation objects). 
 Database icon represents a FullShot Image Database. 

 
To open an image file, navigate and find the file and then single click on it.  
To save an image from the FullShot window to your hard drive, drag and drop the image to the destination 
folder. 
To remove the active image from your hard drive, press Del key on your keyboard. 
To rename a file, select the file and click the filename again. The FullShot Explorer will turn on the 
filename editor for you to change the filename. 
 
You can close FullShot Explorer by clicking the close button on the upper right corner. If you need to turn 
it on, choose the FullShot Explorer command from the View/Toolbars menu. 
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2.6 Capture Effects Settings Bar 
 
By default, the Capture Effects Setting Bar is displayed along with the FullShot Explorer as part of the 
FullShot interface. It provides you a convenient way to change capture effect settings easily to suit your 
changing needs for documentation and presentation work. As the FullShot Explorer, you can enable the 
Auto-Hide to make it hide itself when you work on something else. You can also close it by clicking its 
close button at the upper-right corner. To turn it back on, choose the Capture Effects Settings Bar 
command from the Options menu. 
 

    
 
To learn how to use the Capture Effects Settings, see Chapter 3.6 for details. 
 

2.7 Annotation Objects List 
 
Annotation Objects list is initially empty. You will see it lists an image as the first object after you 
perform a screen capture or open an image file. As you add annotation objects to the active image, it adds 
your objects to the list. Each object is a layer on the image. You can change the order of layers in order to 
set positions for objects. 
 
In the sample below, there is one image object, one rectangular callout object and two vector drawing 
objects. The image object is at the bottom and is locked, which means that you can’t move the image 
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object. To change object layer orders, drag an object and move the mouse pointer up and down the list. For 
more information read Chapter 9.4. 
  

 
 

2.8 Docking Interface Components 
 
FullShot Explorer, Capture Effects Settings Bar and Annotation Objects list are dockable interface 
components that can be docked on any side of the FullShot main window frames. Changing docking side is 
a process of dragging the title bar, moving and releasing mouse button on the side frame. If you find it 
difficult to dock bars where you want to dock, turn on 3D Interface Style 2 from View/Application Look 
menu. 
 

 
 
3D Interface Style 2 will show you exactly where to dock when you drag the title bar. Release the mouse 
button when it is on a navy blue navigation arrow button. 
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2.8 FullShot Status Icon 
 
When FullShot is loaded, the FullShot status icon is displayed in your system tray where your other 
hardware and software icons are displayed. If the status icon is not in the system tray, you may want to 
change your FullShot Settings and turn it on. 
 

 
 
Right click on the FullShot camera icon to open a popup menu. 
 
Open FullShot: Brings FullShot window to top, same as press the hotkey Ctrl+Shift+Alt+F. 
 
Hide FullShot: Hides the FullShot window and the taskbar icon, same as press the hotkey 

Ctrl+Shift+Alt+B. If you choose this command, the status icon will be the only 
object that represents FullShot on your desktop. 

 
Enable Capture Effects: Turn on your previously selected capture effects 
 
Disable Capture Effects: Turn off currently enabled capture effects. 
 
About FullShot: Shows the FullShot version and copyright information. 
 
Remove Status Icon: removes the status icon from the system tray. FullShot will run without this 

icon. 
 
Exit: Quits FullShot. 
 
For more information about the background and foreground mode setup, see FullShot Setup in 3.2. 
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2.10 Capturing Images 
 
1. Start Windows. 
2. Start FullShot. 
3. Minimize FullShot if you wish. 
4. Start the program from which you want to capture screen images. 
5. Click one of the FullShot on-screen Snapshot Buttons. 
 If you prefer to use Hotkeys, the default Hotkeys are: 
  

Full Screen Capture CTRL+1 
Window Capture CTRL+2 
Region Capture CTRL+3 
Title & Menu Capture CTRL+4 
Freehand Capture CTRL+5 
Object Capture CTRL+6 
 
The Professional Edition and Enterprise Edition have five more capture modes: 
 
Mouse Pointer Capture CTRL+7 
Button Capture CTRL+8 
Command Bar Capture CTRL+9 
Document Auto-Scroll Capture CTRL+0 
Interactive Scroll Capture CTRL+F11 
Session Capture CTRL+F12 

 
By default, captured images are displayed in the FullShot windows. 
 

2.11 Viewing Images in Zoom In and Zoom Out Mode 

To view the active image in a larger size, click the Zoom In button on the toolbar.  

To view the active image in a smaller size, click the Zoom Out button on the toolbar.  
 
The image window title bar will display the percentage of the current display mode. The percentage is for 
viewing only and doesn’t affect the image’s actual size when it is saved to a disk. 
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Chapter 3. Setting up Options 

3.1 Settings 
 
FullShot comes with a set of default settings. It works just fine without your changing any of its settings. 
You do have many options, however, if you want to use FullShot differently. In this chapter we present you 
with general settings which affect overall FullShot behavior. In the next chapter, we’ll discuss capture-
related settings. 
 

3.2 FullShot Run Settings 
 
The FullShot Run Settings command opens up the FullShot Run Settings dialog box. 
 

→  
 
You can load FullShot with Windows automatically. You can load FullShot directly in the form of a 
minimized icon on the taskbar or maximized taking the entire screen. 
 
If you choose to run FullShot in the background mode, FullShot will be hidden and it doesn't even appear 
on the taskbar. When you need to switch between the Background mode and the Foreground mode, press 
the hotkey combination Ctrl+Shift+Alt+B and Ctrl+Shift+Alt+F. 
 
You can install the FullShot icon in your system tray to identify its running status. See Chapter 2.8 to learn 
more about the status icon and its popup menu. 
 
By default, the FullShot Setup program has installed the FullShot icon on your desktop. You can let 
FullShot to remove the icon in this dialog box. 
 

3.3 Image Window Settings 
 
The Image Window Settings dialog box allows you to set system wide settings so that all image windows, 
all annotation objects on an image will follow these settings. Please note that the labeling tools are 
available in the Professional Edition and Enterprise Edition only. See Chapter 9 to learn how to 
annotate an image. 
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 →  
 

3.4 Destination Settings 
 
FullShot sends all captured images to the FullShot Window by default. If you need to change the 
destination, you can turn on/off the individual destination buttons on the toolbar. You can also use Capture 
Settings command from the Options menu to set more options. 
 

 Capture to FullShot Window 
 Capture to Printer 
 Capture to Clipboard 
 Capture to File 

 →  
 

If you use FullShot as a direct screen printing program, select the Printer option only, and then set print 
settings (see Chapter 6 for details). If you plan to capture and save many images during a session, you can 
make the process quick and easy by selecting the File as a destination (see Chapter 5 for details). For those 
of you who prefer to use the Clipboard to transfer captured images, select the Clipboard option. 
 
Please note that the Button tab, the Command Bar tab, the Document tab and the Interactive tab are 
available only in the Professional Edition and Enterprise Edition. 
 

3.5 Capture Settings 
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Capture settings in this page affect all of the capture types. 
 

 →  
 
Hide Mouse Pointer: Select if you don’t want the captured image to include the mouse pointer; leave 
unselected if you do want the image to include the mouse pointer. 
 
Bring FullShot to Top: Select if you want the FullShot window to appear above other application 
windows after you capture an image; leave unselected if you don’t want the FullShot window to appear on 
top after image captures. There are four windows display modes. 
 
Display Image Info: Select if you want to see a dialog box showing image attributes immediately after you 
capture it; leave unselected if you don’t want the image info dialog box to appear. 
 
As Is: Select to leave color images unchanged when you capture them. 
 
Black & White: Select to change color images automatically to black & white as you capture them. Please 
note that this function came from the original FullShot 1.0 implementation back in 1991 when Windows 
had only 16 colors. Its matching color scheme was designed for 16-color (4-bit) environment. It is 
preserved in the program as a legacy function. Users are recommended to use either color or grayscale 
mode to do screen capture for modern documentation work. However, if you work on legacy COBOL and 
similar mainframe applications, you may still find Black & White mode useful in dealing with simple color 
screens. 
 
Grayscale: Select to change color images automatically to grayscale as you capture them. 
 
Invert: Select to invert color or monochrome images automatically as you capture them. 
 
Resolution: You can preset a resolution so that all captured images are processed in that resolution. There 
are six preset resolutions: 72dpi, 96dpi, 120dpi, 150dpi, 300dpi and 600dpi. You can also specify a 
resolution. After an image is captured, you can change the image resolution to any value by using Change 
Resolution command from the Tools menu. Resolution option is only available in the Professional 
Edition and Enterprise Edition. 
 
Resize after capture by percentage: If you want the captured image to be scaled larger or smaller in one 
step, you can specify a percentage in this box. Obviously, you can do scaling from the Tools menu 
separately after a capture is done. 
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3.6 Capture Effects Settings 
3.6.1 Effect Commands 
 
There are four capture effects you can use for your capture tasks during capture and after capture. Changing 
settings can be easily done on the capture effect toolbar or on the Capture Effects Settings Bar. 
 
You can find four buttons on the toolbar. If you want to hide the toolbar or show it after hiding, use the 
Capture Effects Toolbar command from the View->Toolbars menu: 
 

    
 
Click an effect button to turn it on and click it again to turn it off. By default, Drop Shadow effect is on 
and all other three are off. Actually, the drop shadow effect has been used on most of images captured for 
this User’s Guide. 
 

 Drop Shadow Effect 

 Stroke Effect 

 Tear Effect 

 Glare Effect 
 
You can also find those four buttons on Capture Effects Settings Bar. Click it to turn on/off an effect. 
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 →  
 
3.6.2 Drop Shadow Settings 
 
Opacity: adjusts the amount of opacity for the shadow. 
Angle: adjusts the angle of the shadow in degree. 
Direction: allows for a preset value for the shadow. It is an alternative to quickly adjust the angle 

parameter. 
Distance: adjusts the simulated distance of the shadow from its background. 
Size: adjusts the simulated size of the shadow. It is in the unit of pixel. 
 
Tip: The Distance setting decides how far a shadow will be away from the image. The larger the value, the 
farther the shadow seems to be. The Size setting decides width of the shadow in pixel. For the Angle 
setting, if you don’t want to figure out where the shadow will be generated by angle, always use Direction 
setting to select one of preset directions: Lower Right, Lower Left, Upper Right or Upper Left. 
 
3.6.3 Stroke Effect Settings 
 
Width: adjusts the width of the stroke in pixel. 
Color: specifies the color of the stroke. 
 
Tip: Use value 1 for the Width if you don’t want to see a strong effect. 
 
3.6.4 Tear Effect Settings 
 
Min: adjusts how far up the tear can be (minimum of image). 
Max: adjusts how far down the tear can be (maximum of image). 
Size: slightly adjusts the randomness of the tear. 
Bottom: applies the tear effect to the bottom edge of the image. 
Top: applies the tear effect to the top edge of the image. 
Right: applies the tear effect to the right edge of the image. 
Left: applies the tear effect to the left edge of the image. 
Uniform: specifies whether or not the tear effect will have uniform teeth. 
 
Tip: Max value should be greater than Min value in order to generate a good tear effect. The Size setting 
decides severity of the tear effect. You can turn on the effect on all four edges of the image. 
 
3.6.5 Glare Effect Settings 
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Amount: adjusts the amount of glare (brightness on top part of image). 
 
3.6.6 How to Change Settings 
 
FullShot has preset a value for every setting that should look good for most of cases. If you’d like to change 
any setting, double click the name of the setting or single click the setting itself. For example, if you want 
to increase or decrease the opacity of drop shadows, double click Opacity: 
 

   
 
User direction keys on the keyboard (←↑→↓) to change the setting. For the Direction setting of the Drop 
Shadow effect, click the setting to open a drop-down menu and select a direction. 
 
Here are five capture samples. They are all captured by using the Menu Capture (Ctrl+4) when the 
Options menu is open.  
 
Figure 1: no effects used. 
Figure 2: drop shadow effect used. 
Figure 3: drop shadow and bottom tear effects used. 
Figure 4: drop shadow, stroke and bottom tear effects used. 
Figure 5: drop shadow, stroke, bottom tear and glare effects used. 
 

      
 
Since tear effects are generated randomly, no two images will have the same tear effect. 
 
3.6.7 Apply Effects Command 
 
Effects, if turned on, are automatically applied when you launch a capture. If you have already captured 
images or obtained images from other sources, you can apply effects to a loaded image: 
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3.7 Snapshot Button Settings 
 
Snapshot Buttons are the easiest way to capture images. Nine of the twelve capture types have a snapshot 
button. The Mouse Pointer capture does not need a snapshot button; the Title & Menu capture cannot use 
a snapshot button. You can turn on/off any snapshot button and change button size through the Snapshot 
Button Settings dialog box. 
 

 →     
 

There are four more Snapshot Button types in the Professional Edition and Enterprise Edition: 
 

Select the Hide in Capture option if you don't want to see the snapshot button image in your captured 
images. 
 

3.8 Hotkey Settings 
 
Hotkeys are the second way to capture images. Each of the twelve capture types has its own hotkey or 
hotkey combination. A hotkey combination can be any key (except F1, which is used for Help) and one or 
more of these system keys: CTRL, SHIFT, ESC and ALT. The default hotkey settings are: 
 
CTRL + 1 Screen Capture 
CTRL + 2 Window Capture 
CTRL + 3 Region Capture 
CTRL + 4 Title & Menu Capture 
CTRL + 5 Freehand Capture 
CTRL + 6 Object Capture 
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The Professional Edition and Enterprise Edition have six more capture modes: 
 
CTRL + 7 Mouse Pointer Capture 
CTRL + 8 Button Capture 
CTRL + 9 Command Bar Capture 
CTRL + 0 Document Auto-Scroll Capture 
CTRL + F11 Interactive Scroll Capture 
CTRL + F12 Session Capture 
 

 →  
 

You can change hotkeys easily through the Hotkey Settings dialog box. 
 
You need to use the mouse to select hotkeys. If you use a number key from the numeric keypad, make sure 
NUM LOCK is turned on. Do not use SHIFT in combination with number keys from the numeric keypad. 
 
If you don't want to use any hotkeys, select Turn off all hotkeys. FullShot will not monitor any keyboard 
activities when the hotkeys are in the sleep mode. 
 
Tip: In general, it’s best to select hotkeys that won’t conflict with keys your current application uses. If a 
FullShot hotkey matches the key for an application, pressing it first carries out the action your application 
defines for the key and then captures an image. Thus, you may find that the application has changed the 
image you wanted to capture. The easiest way to avoid such conflicts is define a hotkey combination that, 
like the default selections, includes one or more systems keys, for example, CTRL+1 for screen captures. 
 
Tip: FullShot’s keyboard display always includes the standard 101 keys. If your keyboard has a different 
number of keys, make sure you select only hotkeys that are actually available on your keyboard. 
 

3.9 FullShot Clock Settings 
 
The FullShot Clock Settings has nothing to do with image captures. It is for your convenience. The clock 
is always displayed next to the Snapshot Buttons on the title bar of the active window. You can change its 
settings and color through a dialog box. 
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 →  
 
To turn off the clock, unselect both the Time and Date options. By default, the FullShot clock will not be 
displayed on the title bar of a dialog box. Select On Dialog Title Bar option if you want to see the clock on 
the active dialog box. 
 

3.10 Master Reset 
The Master Reset command allows you to change all settings to their original defaults. If you want 
FullShot to work in the factory default method, use this command. 
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Chapter 4. Capturing Images 

4.1 Capturing a Screen 
 
A screen capture includes everything you see on your display screen or everything in the area you define. 
By default, screen captures include the whole screen.  
 
To capture a screen: 
 

Click  button or 
Press the currently defined hotkeys (e.g. CTRL+1) 

 
You can change the screen capture area within your monitor resolution through the Capture Settings 
command. 

 →  
 
FullShot supports multiple monitors. In the screen capture settings, you can select either the Primary 
Monitor only or All Monitors. 
 

FullShot lets you set a countdown timer for screen capture. This feature can help you capture screens that 
might change with any keystroke or mouse click. A capture is delayed for the number of seconds you 
specify so you have time to arrange the screen the way you want it to look. 
 

To use the countdown timer: 
 
1. Select the Countdown option. 
2. Specify the number of seconds. 

3. Click  or press the current hotkeys to start the capture. 
 Timer beeper starts. 
4. Arrange the screen the way you want to capture it. 
 After the number of seconds you specify, FullShot automatically captures the screen. 
5. Turn off the countdown timer after capturing the screen. 
 

4.2 Capturing the Active Window 
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FullShot lets you capture not only complete screens, but also separate ‘windows’ that are part of a screen. 
‘Windows’, in this sense, refers not only to full size application or document windows, but also to smaller 
objects within these windows, such as dialog boxes. 
 
An active window is a window on top of other windows. A dialog box is an active window; an application 
window is an active window, etc. There can be only one active window at anytime. FullShot has its own 
way to recognize the active window. As long as the Snapshot Buttons can be displayed on a window’s 
title bar, that window is the active window. 
 
To capture an active window: 
 

Click  button or 
Press the currently defined hotkeys (e.g. CTRL+2) 

 
As in the screen capture mode, FullShot lets you set a countdown timer for window capture. This feature 
can help you capture a window that might change with any keystroke or mouse click. A capture is delayed 
for the number of seconds you specify so you have time to arrange the window the way you want it to look. 
 
To use the countdown timer: 
 
1. Select the Countdown option. 
2. Specify the number of seconds. 

3. Click  or press the current hotkey to start the capture. 
 Timer beeper starts. 
4. Arrange the window the way you want to capture it. 
 After the number of seconds you specify, FullShot automatically captures the window. 
5. Turn off the countdown timer after capturing the window. 

 

 →  
 

4.3 Capturing an Object 
An object is a component that’s part of an application displayed by on the screen. It can be a window, a 
dialog box, a button, a menu, a list control, a tree control, etc. For training or documentation purposes, you 
may want just to capture a small component instead of a large window. The Object Capture is designed to 
serve this purpose. 
 
To capture an object: 
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1. Click  button or press the currently defined hotkeys (e.g. Ctrl+6). The mouse pointer turns to an 

arrow with a question mark.  
 
2. Select an object bordered by a color frame (red, yellow, blue or green). 
3. Single-click the object to capture it. 

 

 
 
Tip: FullShot uses red to frame a generic window, green to frame a tree control, blue to frame a list control, 
and yellow to frame the system default toolbar and toolbar button. 
 

4.4 Capturing a Region on the Screen 
 
The Region Capture lets you define any arbitrary rectangular area on the screen to capture. There are three 
shapes you can use in this capture: Rectangle, Rounded Rectangle and Ellipse. By default, rectangle is 
used in the Region Capture. 
 

 →  
 
To capture a region on the screen: 

 

1. Click  button or 
 Press the currently defined hotkeys (e.g. Ctrl+3) 
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 The mouse pointer turns to a crosshair.  
2. Move the pointer to a corner of the area you want to capture and press the left mouse button to anchor 

the starting point. 
3. With the left mouse button held down, drag the mouse pointer to the corner diagonally opposite to the 

starting point until the flexible box completely surrounds the area you want to capture. 
4. Release the mouse button. The flexible box disappears and the area it encircled is captured. 

 

4.5 Capturing a Menu 
 
The title & menu capture defines a rectangle area that includes all the objects you select. FullShot can 
recognize and separate four title/menu objects. If you want to omit any part of the captured area that is not 
an actual part of a menu object, select the Erase Background option. 
 
To capture a dropdown menu or popup menu: 
 
1. Open the menu you want to capture. 
2. Press the currently defined hotkeys for title & menu capture (e.g. Ctrl+4) 

 
There are limitations to the dropdown menu captures. If you cannot capture a particular dropdown menu 
from an application, that's because the dropdown menu might be implemented in a different way. 
Especially when the menu bar is implemented as a special toolbar, menu capture may fail. If that's the case, 
try to use the Command Bar Capture mode, available in the Professional Edition and Enterprise 
Edition. 
 

 →  
 

4.6 Capturing an Area Freehand 
 

The Freehand Capture lets you capture any arbitrarily shaped area on the screen. 
 

To capture an area freehand: 
 

1. Click  button or 
 Press the currently defined hotkeys (e.g. Ctrl+5) 

 The mouse pointer turns to a pen.  
2. Move the pointer to an edge of the area you want to capture and press the left mouse button. 
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3. With the mouse button held down, drag the mouse pointer around the area you want to capture until 
the border surrounds it completely. If you don’t join the edges of the figure you draw, FullShot will 
calculate the capture area for you. 

3. Release the mouse button. The surrounded area is captured. 
 

Below is a freehand capture sample. 
 

 
 
There are several options you can set for the freehand capture. 
 

 →  
 

4.7 Capturing the Mouse Pointer 
 
The Pointer Capture is available only in the Professional Edition and Enterprise Edition. 
 
In many programs, the mouse pointer changes depending on the action you are carrying out. For example, 
when you select the Airbrush tool from the toolbox in the Windows Paint program, the mouse pointer 
changes to an airbrush image. FullShot lets you capture the current mouse pointer as a separate image in 
any form. 
 
Mouse pointer capture samples: 
 

 
 

To capture the mouse pointer: 
 
 Press the currently defined hotkeys (e.g. Ctrl+7) 
 

There is no setting you need to set for the mouse pointer capture. 
 

4.8 Capturing a Button 
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The Button Capture is available only in the Professional Edition and Enterprise Edition. This tool was 
designed for Windows 2000 or earlier Windows versions. For newer versions, you can use the Object 
Capture tool to capture most of buttons. 
 
There are many buttons on the screen - 3D style buttons and flat style buttons. They can be of any size. 
They can be placed next to each other. Using the button capture, you can capture buttons individually. 
 
Button capture samples: 
 

 
 
To capture a 3D style button: 
 

1. Click  button. 
 The mouse pointer turns to an arrow-on-button shape.  
2. Click the button you want to capture. 

 
To capture a flat style button: 
 
1. Park the mouse pointer over the button to make it 3D look. 
2. Press the currently defined hotkeys (e.g. Ctrl+8) 

 
Select Add a frame around the button if you want to have a black single line border around the captured 
images. There are many button images captured from FullShot in this User's Guide. All of them are 
captured with the Add a frame around the button option selected. 
 
 

 →  
 

4.9 Capturing a Command Bar 
 
The Command Bar Capture is available only in the Professional Edition and Enterprise Edition. 
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A Command Bar is a general name for all kinds of toolbars, menu bars, resizable bars, coolbars, etc. Some 
of them can be docked on any side of a main window, and others can float around on the screen. There can 
be a dropdown menu and submenus from a command bar. The command bar capture is designed to capture 
this type of images. 
 
In the traditional interface, the menu bar can not be moved and it always stays under the title bar. You need 
to use the Title & Menu Capture to capture menu bar and dropdown menu images if that's the case with 
your application. However, if the menu bar is designed using a toolbar or resizable bar or movable bar 
style, it becomes a kind of Command Bar. You need to capture menu images using the Command Bar 
Capture for that interface. 
 
There are three options you can select in the command bar capture setup. The sample image in the 
Command Bar property page shows a floating toolbar with a dropdown menu. 
 

 

→  
 
To capture a command bar without a dropdown menu: 
 

1. Click  button. 

 The mouse pointer becomes arrow-on-a-bar shape.  
 
2. Click on the command bar you want to capture. 

 
Here are two capture samples. 

 

 
 

 
 

To capture a command bar with dropdown menus: 
 
1. Click the command bar button to open the dropdown menu and submenus if any. 
2. Press the hotkey (e.g. Ctrl+9). 

 
Let's see a capture sample. 
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4.10 Capturing a Long Document 
 
The Document Capture is available only in the Professional Edition and Enterprise Edition. 
 
The content of a window is called a document in FullShot. A document can be a web page, a spreadsheet, a 
word processing document or a layout design. When a document is larger than a window viewing area, the 
displaying window can't display all of its content. Document Capture can help you capture such a 
document by using auto-scroll method. 
 
To capture a long document: 
 

1. Click  button or press the currently defined hotkeys (e.g. Ctrl+0). 

2. The mouse pointer becomes arrow-with-scroll shape.  
 
3. Click on the document you want to capture. 
4. FullShot will automatically scroll the document vertically and try to capture the entire document. 

 
To stop a long document capture, click anywhere on the screen. FullShot will just show you whatever it has 
captured. 
 
There are two algorithms in the FullShot auto-scroll technology. They are designed to deal with different 
types of contents. If the algorithm 1 can’t capture your document, try algorithm 2. 

 

Please note that FullShot may not be able to capture a long document from all of the windows even though 
we have designed two algorithms. Some applications use non-standard or special scroll method, or even 
special window rendering routines. As a result, FullShot auto-scroll may fail to make a window scroll 
automatically. In this case, you can use the Interactive Scroll Capture method or you can capture 
individual window content and then use the image merge function to manually make a long document shot. 
 
Some windows may contain extra edges that affect the scroll effect. You can use the Line Adjustment 
parameters to eliminate unwanted area. You can also add a frame automatically after a document capture is 
performed. To set options, click the Document tab in the Capture Settings. 
 
The performance of a long document capture depends on your system RAM. Since the final bitmap image 
can be very large, make sure you have sufficient memory available for a very long document. 
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 →  
 

4.11 Interactive Scroll Capture 
 

The Interactive Scroll Capture is available only in the Professional Edition and Enterprise Edition. 
 
The Interactive Scroll Capture is an extension of the Document Auto-Scroll Capture. There are a lot of 
applications that FullShot may not scroll their window automatically. As a result, the Document Auto-
Scroll Capture can’t capture the entire hidden window content. If that happens, use the Interactive Scroll 
Capture instead, which works interactively with the user to perform Scroll-and-Capture function. As for 
the Document Auto-Scroll Capture, the Interactive Scroll Capture also has two algorithms. Try algorithm 2 
if the algorithm 1 can’t capture your document. 
 
To capture a vertical long document with Interactive Scroll method: 
 

1. Click  button or press the currently defined hotkeys (e.g. Ctrl+F11). 

2. The mouse pointer becomes arrow-with-ISC shape.  
3. Click on the window you want to scroll and capture. 
4. FullShot will capture the current portion of the window and wait for you to scroll the window. 

5. Click on the down scroll button of the window.  
6. FullShot will automatically analyze your scroll and capture the newly exposed portion of the window. 
7. Repeat steps 5 and 6 until the scroll button reaches the bottom of the scroll bar or you decide to stop. 
8. Press any key on the keyboard or right click the mouse button to stop the Interactive Scroll Capture. 
 

FullShot will stitch all portions it has captured to make a complete image. 
 
To capture a horizontal long document with Interactive Scroll method: 
 

1. Click  button or press the currently defined hotkeys (e.g. Ctrl+F11). 

2. The mouse pointer becomes arrow-with-ISC shape.  
3. Click on the window you want to scroll and capture. 
4. FullShot will capture the current portion of the window and wait for you to scroll the window. 
5. Click on the right scroll button of the window.  
6. FullShot will automatically analyze your scroll and capture the newly exposed portion of the window. 
7. Repeat steps 5 and 6 until the scroll button reaches the right border of the scroll bar or you decide to 

stop. 
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8. Press any key on the keyboard or right click the mouse button to stop the Interactive Scroll Capture. 
 

FullShot will stitch all portions it has captured to make a complete image.  
 
As you can see, the horizontal interactive method is very similar to the vertical interactive method. The 
only difference is step 5. The vertical scroll method waits for you to click the down scroll button; the 
horizontal method waits for you to click the right scroll button. 
 
You can let FullShot add a frame automatically after the capture is done. To set this option, click the 
Interactive tab in the Capture Settings. 
 

 →  
 

4.12 Session Capture 
 

The Session Capture is available only in the Professional Edition and Enterprise Edition. 
 
Session Capture provides a way to capture many screens without user’s interaction. Each capture is triggered by a 
timer preset by the user. Once started, FullShot will perform the specified capture whether or not there is any screen 
change. The captured images will be automatically saved to a specified folder or a specified FullShot image database. 

 
To set a capture session, choose the Session Capture Settings command from the Options menu.  
To start a capture session: press the currently defined hotkeys (the default is Ctrl+F12). The session will be 
ended automatically when the time limit or capture limit is reached. The session can also be ended before 
any limit is reached by pressing the same hotkeys. You can change the session capture hotkey in the 
Hotkey Settings dialog box. 
 

 →  
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Full Screen: FullShot will capture a full screen. 
Current Window: FullShot will capture the top most window. 
Use Capture Notification: FullShot will use a sound or screen flash to signal that a capture is done. 
Display Report after a Session: FullShot will display the statistics. 
 

 
 
Time Interval: This is the timer that triggers each capture. The minimum interval is 1 second. 
Capture Limit: use either the total capture or total time as a limit to stop the session capture. You can also 
stop a session by pressing the same hotkey sequence that launches the session capture. 
 

 
 

The user can tell FullShot to save captures to a folder or a database. The database option is available in the 
Enterprise Edition only. To select a local database for a session capture, click the Database button. 
 

 →  
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If you need FullShot to set record fields for each capture, click the Set Field button to enter field values. 
 

 →  
 

4.13 Capturing Video Images 
FullShot can capture video images played by a media player. However, you may need to turn off 
hardware acceleration in order to capture video images. 
 
To capture a video image from a media player: 
 
1. Right click your Desktop and choose the Properties command. 
2. Under the Settings tab, press the Advanced button. 
3. Under the Troubleshooting tab (also called Performance tab in earlier Windows versions), 

move the Hardware Acceleration slider to None. 
4. Press Apply or OK button. 
 

→  →  
 
5. Play your video and pause the play. 
6. Launch a capture – Screen Capture, Window Capture or Region Capture. 
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Chapter 5. Working with Image Files 

5.1 Image File Conversion 
 
FullShot lets you open and save files in many popular image formats. You can open a file in a supported 
format even if it was created by another application; thus FullShot can act as an image file conversion 
program. 
 

5.2 Supported Formats 
 
18 popular image formats are supported in FullShot. 
 
FSD FullShot document format that can store images and annotation objects. 
BMP Windows Bitmap format, the Microsoft standard format for Windows. 
CUR Windows Cursor format, the format used to store cursor images used for Windows applications. 
DIB Windows Device-Independent Bitmap format, a variant name for the BMP format. 
EPS Encapsulated Postscript format. FullShot will display its preview image. 
GIF Graphics Interchange Format, a popular image exchange format used many websites. However, it 

supports only 256 colors. 
ICO Windows Icon format, the format used for on-screen icons in Windows. 
JPG Also known as JPE and JPEG. Joint Photographic Experts Group format used for true color 24-

bit photographic images scanned or digitized from films. 
PCD Kodak Photo CD format. 
PCT Macintosh Pict format. 
PCX Originally Painbrush format, supported by many desktop publishing and graphics programs. 
PNG Portable Network Graphics, a standard specified by the World Wide Web Consortium for Internet 

and web development. 
PSD Adobe PhotoShop format. 
RAS Sun Raster format. 
RLE Windows Run-Length Encoded bitmap format, a compressed version of standard Windows BMP 

format. 
TGA Truevision TARGA format. 
TIF Tagged Image File format, supported by many desktop publishing programs. 
WMF Windows Metafile Format. FullShot can handle bitmap or raster images in this format, not vector 

images. 
WPG WordPerfect Graphics format, supported by the WordPerfect word processing and graphics 

program. FullShot can handle bitmap or raster images in this format, not vector images. 
 
FullShot also has its own document format FSD to save annotation objects. 
 

5.3 Opening or Importing an Image File 
 
To open an image file, navigate and find the file using the FullShot Explorer. And then left click on the 
filename to load it into a separate FullShot window. To open an image file into the top window, right click 
it. 
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You can also click the Open button on the toolbar and use the traditional method to open an image file. 

 
 

5.4 Saving an Image to a File 
 
To save an image to a new file: 
 
1. Find the target folder in the FullShot Explorer where you want to save your image. 
2. Click on the image in the FullShot window. 
3. Hold down the mouse button and drag the mouse pointer to the target folder name in the FullShot 

Explorer. 
4. Release the mouse button when you see the target folder is highlighted. 
5. FullShot opens the Save As dialog box. 
6. Select a file format in the Save As dialog box. 
7. Type a filename in the Save As dialog box. 
8. Click Save. 

 
To save an image to an existing file: 
 
1. Find the target file in the FullShot Explorer. 
2. Click on the image in the FullShot window. 
3. Hold down the mouse button and drag the mouse pointer to the target filename in the FullShot 

Explorer. 
4. Release the mouse button when you see the target filename is highlighted. 
5. Click the Yes button to confirm that you want to replace the image file. 
 

To save an image automatically as you capture it: 
 
1. Choose the Capture Settings command from the Options menu. 
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 →  
 

2. Select the File destination. 
 You may want to unselect other destinations. If the File option is the only destination, all captured 

images will directly go to your hard drive. 
 
3. Select a File Option. 
 Increment Filename: When saving files, FullShot automatically assigns the filename and file type set 

with Set File. If the filename ends in a number (e.g. the default filename is 'SHOT0000.BMP'), FullShot 
increases the number sequentially for each new file. By default for example, the next filename will be 
SHOT0001.BMP. If the filename doesn't end in a number, FullShot automatically overwrites any file 
already saved with the currently set name. 

 
 Prompt Filename: When saving files, FullShot opens the Save As dialog box that lets you set a 

filename and file type. 
 
 Filename by Time: When saving files, FullShot automatically creates a filename using the current date 

and time in the form of MM-DD-YY (HHMMSS), where MM is the current month, DD the date, YY 
the year, HH the hour, the second MM the minute, SS the second. For example, a PNG file created on 
11/30/2005 at 8:05:16AM is saved under the name 11-30-05 (080516).PNG. You can use FullShot 
Clock Settings dialog box to change the time format. 

 
 If you select the Increment Filename, continue with the rest of steps. Otherwise, your setup is 

complete. Click OK. 
 

4. Click Set File to set options. 
 The Set File opens up the standard FullShot Save As dialog box. You need to choose a directory, a file 

format, and a starting filename with one or more digits at the end. FullShot saves the captured image by 
default as a BMP file under the name SHOT0000.BMP in your current working directory. 
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5. Click the Save button. 
 FullShot will remember your settings and save captured images sequentially when you perform a 

capture. 
 
6. Start a capture. 
 Please be aware that all captured images are saved to your hard drive directly. FullShot will not display 

them unless you also select the FullShot Window as a destination. 
 

5.5 Batch Save All Images 
If there is more than one image in the FullShot main window that you want to save to files, you can do it in 
a quick and easy way by using the Save All command. 
 

   
 

To save all images to files: 
 
1. Choose the Save All Images command from the File menu.  
 The standard FullShot Save As dialog box opens up. 
2. Choose a target directory (folder). 
3. Choose a filename. 
4. Click Save. 
 

Suppose that you have 20 images. Suppose that the filename you use is MYFILE.GIF. And then FullShot 
will save your images as MYFILE01.GIF, MYFILE02.GIF, MYFILE03.GIF … MYFILE20.GIF. 
 
Selecting Automatic Color Reduction option will guarantee that you save all the images in the minimum 
color format. 
 

5.6 Graphics Mode and File Size 
 

The way Windows is set up on your system influences how efficiently FullShot runs and how much 
information it needs to hold in memory or save to a file. There are two important concepts you need to 
understand. 
 

1. Color Mode. Most display adapters used for Windows offer one or more of the following color modes: 
 
16 Color  Uses 4 bits for every pixel to display 16 distinct shades. 
256 Colors  Uses 8 bit for every pixel to display 256 distinct shades. 
High Color  Uses 15 or 16 bits for every pixel to display 32,768 or 65,536 distinct shades. 
True Color Uses 24 bits for every pixel to display 16.8 million distinct shades. 
 
Although higher color modes give a wider range of possible colors, they also require greater processing 
power and generate larger image files. To make image captures more efficient, we recommend that you use 
the lowest color mode possible. Most screen captures won’t benefit from a mode higher than 256-colors. 
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2. Resolution. Graphics cards can provide one or more of the following resolutions: 
 
640 x 480 pixels 
800 x 600 pixels 
1024 x 768 pixels 
1152 x 864 pixels 
1280 x 1024 pixels 
1600 x 1200 pixels 
 
Higher resolution means greater clarity and more contents, but also larger image files.  
 

If you want to save your image in the smallest format possible, you can use Compare and Save command 
from the File menu or press Ctrl+M. It not only lists all file sizes for supported formats, but also tells you 
whether or not it is a good idea to save in GIF format. As we mentioned earlier, GIF format can contain 256 
colors only. Saving an image with more than 256 colors in GIF format will product color dithering effect 
that is not good for documentation or online help 
 

→  
 

5.7 Color Reduction 
 

If you want to get smaller image files for your captures, you may set up Windows as a 16-color or 256-
color environment before you capture images. All high-color graphics cards come with drivers that support 
16-color and 256-color modes. But if you need to run your Windows in a high-color or true color mode, 
you can do color reduction to produce smaller image files. 
 
There are two ways you can reduce the amount of colors in images. 
 
1. Select the Automatic Color Reduction option in the FullShot Save As dialog box. All of the images 

will be analyzed and preprocessed individually before they are saved. This option will generate image 
files in the minimum color format. 

 
2. Choose the Reduce Color command from the Color menu to reduce the amount of colors in the active 

image. 
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5.8 Image Compression 
Certain image formats provide compression. PCX, GIF, PNG, WPG, RLE and JPG, for example, 
are compressed image formats. 
 
RLE is suitable only for 16-color and 256-color images. If you save a black-and-white 
image or color image with more than 256 colors, FullShot does not provide compression 
in the RLE format. 
 
The TIFF (extension TIF) specification allows many different compression methods. 
FullShot can read most of them but does not provide any compression when saving files 
in TIFF format because of compatibility concerns. 
 
The JPEG format (extension JPG) is supported mainly to let users import and export 
photographic images. It has the best compression algorithm for true color photographic 
images, and it can generate a very small image file. However, decompressing an encoded 
JPEG image does not necessarily restore the original bit-for-bit. As a result, you 
should not save screen images in JPEG format because they will not look as sharp 
when they are decompressed. 
 
PNG format is a lossless specification and supports 1-bit, 4-bit, 8-bit and true 
color image. It has better compression ratio than GIF. As a result, PNG format is 
highly recommended to all FullShot users. 
 
Since FullShot supports the most popular formats for desktop publishing, you should 
be able to find a format you can use with almost any desktop publishing or graphics 
program. If you are not sure which format to use, try BMP or PCX format for the greatest 
degree of compatibility with other applications. Since PCX files have built-in compression, 
they are generally smaller than BMP files. 
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Chapter 6. Printing Images 

6.1 Configure FullShot as a Screen Printing Program 
 
If you want FullShot to work like a screen-printing program, you need to send captured images directly to 
your printer. Follow the instructions below to make appropriate configuration. 
 
1. Choose the Capture Settings command from the Options menu. 
 

 →  
 
2. Select the Printer destination. 

Make sure the Printer is selected as the only destination. When a capture of any type is performed, 
FullShot will send the screen image to your printer directly. 

 
3. Select the Use Print Dialog Box option if you want to see the preview before you print. 

We recommend you to select this option because you will have a chance to adjust scaling so that the 
image is printed on the page the way you want it. You can also write some notes under or above the 
printed image in the notepad provided in the print dialog box. 

 
4. Click Set Print to set options. 

 

 
 

This will open up the FullShot Print dialog box. The dotted line indicates how much space a full screen 
image of your current screen will take on a page. Different screen resolution or different printer 
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resolution will have different preview size. Changing scaling parameter will affect the image size on 
the page. If you have selected the Use Print Dialog Box option in the step 3, the image size in the 
preview window doesn't matter because you can change the scaling for every image you print. 
 

5. Click OK to complete the setup. 
6. Start a capture. 
 From now on, any capture of any type, large or small, will be treated as a screen-printing. 
 
If you want to save the captured images, you need to unselect the Printer as the only destination and 
select other options. 
 
You can turn on/off the Printer as a destination by clicking the Capture to Printer button on the toolbar. 

 
 

6.2 Print Images from FullShot Window 
 

There are three image printing commands on the File menu: 
 

Print Image 
Print All One by One 
Print All 
 
To print the image in the active FullShot window: 
 

1. Click the Print Image button on the toolbar.  
 The image in the active window is displayed in the preview window. 
2. Select a target printer from the printer list. 
3. Set the Number of copies. 
4. Adjust the Scaling parameter to make the image larger or smaller against the simulated page. 
5. Choose Portrait or Landscape mode. 
6. Click OK. 
 

 
 
Pixel Perfect Print (Round scaling factor for clarity) Option 
 
Certain scaling parameters may distort images that contain text. Pixel Perfect Print is designed to provide 
you with better quality printing. Check this option box if you’d like to see better quality. It dictates your 
preview scaling image size change. The internal algorithm decides what scaling parameter can produce 
good quality of image printing. 
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To print images in all FullShot windows: 
 
Choose the Print All One by One command from the File menu. This command will sequentially print 
each and every image in the FullShot window. 
 
Follow the same steps in printing the active image. Please note that you may preview all of the images one 
by one before you print them. The example below shows that 7 images will be printed and the image 5 is 
being previewed. Click Back or Next button to preview other images. 
 

 →  
 

To print all images on one or more pages: 
 
Choose the Print All command from the File menu. 
 

 →  
 

When the FullShot Print dialog box comes up, images in the FullShot window will be displayed based on 
Column and Row settings. If you do not want to print a particular image, drag it out of the preview 
window, and FullShot will eliminate it from the page layout. 
 
Each image takes up equal space on the page. Select the Show Grid option and the preview window will 
display dotted lines to let you know how the space is allocated. You can drag an image to another location 
and FullShot will automatically reformat the page layout. 
 
The Column and Row are important factors that affect the page layout. Increase or decrease column count 
or row count will generate a different page layout. There are 4 images in the above example, and they are 
displayed in 2x2 layout in the Portrait mode. If we choose to print the same images in 4 columns in the 
Landscape mode, the page layout will be totally different. 
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6.3 Notepad 
 

The notepad in the FullShot Print dialog box allows you to enter a short description about the image. 
 

 
 

FullShot has default formatting for printing image notes. You can make a formatting change by clicking on 
other options. If you don't want to print the image notes, unselect the Print with image option. 

6.4 Header and Footer 
 
You can add a header to all printed pages at three possible locations. You may use macros in the header. 
You can change the font to make the header larger or smaller. 
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You can add a footer to all printed pages at three possible locations. You may use macros in the footer. You 
can change the font to make the footer larger or smaller. 
 

 
 

6.5 Macros 
 

A macro in FullShot is a single print conversion command that is translated into a FullShot action. 
$printdate, for example, is translated into the current printing date. It gives you a way to define a header or 
footer once and get consistently formatted printout. FullShot supports six macros in the notepad, header and 
footer.  
 
By default, the header on the right is defined as ‘printed by FullShot at $printtime on $printdate’; the footer 
on the left is defined as ‘$filename, $filetime - $filedate, $res’. 
 

 
 
Date and time used in the macros can be in different formats. Click Set Date/Time Format to change the 
format to the way you like it. 
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Chapter 7. Working with the Clipboard 

7.1 Edit Commands 
 

 
 

Use the Copy command to copy the image or selected annotation objects in the active window to the 
Clipboard. 
 
Use the Copy Merged command to copy the image and all annotation objects as an integrated image in the 
active window to the Clipboard. 
 
Use the Paste command to duplicate the image or annotation objects in the Clipboard to the active image. 
 
Use the Paste As New command to display the image in the Clipboard in a new FullShot image  
 
Use the Undo command to undo an image editing and annotation action. 
 
Use Redo command to revert the previous undo. 
 
The Image Attributes command displays information about the active image. 
 
The Summary Report command displays ImageExplorer statistics information. 
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Chapter 8. Changing Images 

8.1 Resize 
 
The Scale command from the Tools menu lets you scale images flexibly, but it can distort the image if your 
changes are not exactly multiples of the original, particularly if the image contains text. 
 

 →  
 

8.2 Rotate and Flip 
 
To change the orientation of the active image, choose one of the four orientation commands from the Tools 
menu. Suppose the original image is . 
 

 Flip Horizontal ⇒  

 Flip Vertical ⇒  

 Rotate Right ⇒  

 Rotate Left ⇒  
 

8.3 Change Resolution 
 
This function is not available in the Standard Edition. 
 
To change image resolution: 
 
1. Choose the Change Resolution command from the Tools menu. 
2. Set new resolution. 
3. Click OK. 

 
This function doesn't generate a new image window. 
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 →  
 

8.4 Merge 
 
To merge two or more images into one: 
 

1. Select Auto Stretch Canvas mode in the Canvas Properties dialog box. This is the default mode for 
newly captured or imported images. (see Chapter 9.2 for more information) 

2. Drag one image to another image window. 

3. Position images.  
4. Use Annotation Objects list to arrange the object layer positions. (see Chapter 9.4 for more 

information) 
5. If you would like to generate a merged image immediately, press the Merge to New Image button on 

the Annotation Objects list.  Otherwise, go on to add more annotation objects. 
 

 
 

There is no limit on how many images you can merge at a time. To delete an image in the merging window, 
bring it to top, and then press the Delete key on the keyboard. 
 

8.5 Black & White, Grayscale and Invert 
To change the active image to black & white, use the Black & White command from the Color menu. 
 
Please note that this function came from the original FullShot 1.0 implementation back in 1991 when 
Windows had only 16 colors. Its matching color scheme was designed for 16-color (4-bit) environment. It 
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is preserved in the program as a legacy function. Users are recommended to use either color or grayscale 
mode to do screen capture for modern documentation work. However, if you work on legacy COBOL and 
similar mainframe applications, you may still find Black & White mode useful in dealing with simple color 
screens. 
 
To change the active image to grayscale, use the Grayscale command from the Color menu. 
 
To change each color in a color image to its complementary color, use the Invert command from the Color 
menu. 
 

     
 

8.6 Reduce Colors 
 
To reduce the number of colors in the active image, choose the Reduce Colors command from the Color 
menu. 
 

 
 

This function results in a smaller file size with no loss of quality, so it is always wise to reduce colors if you 
can. FullShot first analyzes the image. If it is a true color image, it will try to reduce it to the 256-color 
level; if it is a 256-color image, it will try to reduce it to the 16-color level. 
 

8.7 Crop 
 
The cropping function lets you trim one or all four edges of an image to eliminate parts you don’t want. 
You can crop each edge separately or all four at once using cropping lines that appear when you select the 
image. 
 
To crop an image: 
 

1. Set the editing mode to the Crop mode.  The mouse pointer becomes a crosshair.  
2. Double click the active image to draw the cropping lines at the edges of the image or draw the 

cropping lines on the image at the position you prefer. 
3. Move the cropping lines by dragging one of the handles on the cropping lines or use keys to move 

lines precisely. 
4. Press the ENTER key or double click the image to complete the crop operation. 
5. A new image is generated and displayed in a new image window. 
6. If you are not satisfied with the crop result, go back to modify crop lines and do it again. 
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Keyboard interface is defined as follows: 
 
← → Moves the cropping object; with Ctrl key held down, moves the right cropping line; with 

Ctrl+Shift keys held down, moves the right cropping line. 
↑ ↓ Moves the cropping object; with Ctrl key held down, moves bottom cropping line; with Ctrl+Shift 

keys held down, moves the top cropping line. 
i Moves all four cropping lines in toward the center of the image. 
o Moves all four cropping lines out toward the edges of the image. 
 

8.8 Blur 
 
The blur tool allows you to block certain information on the active image from being exposed to public. 
 
To blur part of  an image: 
 

1. Set the editing mode to Blur mode.  The mouse pointer becomes a crosshair.  
2. Draw an area to blur it. 
 

8.9 Highlight 
 
The highlight tool allows you to highlight certain information on the active image using the yellow marker 
pen style. 
 
To highlight part of  an image: 
 

1. Set the editing mode to Highlight mode.  The mouse pointer becomes a crosshair.  
2. Draw an area to highlight it. 
 

8.10 Eraser 
 
The eraser tool allows you to erase certain information on the active image. 
 
To erase part of  an image: 
 

1. Set the editing mode to Eraser mode.  The mouse pointer becomes a crosshair.  
2. Draw an area to erase it. 
 

8.11 Check Colors 
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The check color function allows you to display a pixel’s RGB value. 
 
To check a pixel’s color value: 

1. Set the editing mode to Check Color mode.  The mouse pointer becomes a black arrow.  
2. Click the pixel on the active image to display its RGB value. 
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Chapter 9. Adding Annotations 

9.1 Annotation Basics 
 
Annotation is a way to draw and write your comments into an image. There are three sets of annotation 
tools: 
 
Drawing Tools: Standard, Professional and Enterprise Editions. 
Callout Tools: Professional and Enterprise Edition. 
Labeling Tools: Professional and Enterprise Edition. 
 

9.2 Canvas and Editing Modes 
 
9.2.1 Canvas 
 
The annotation editor is embedded in the image window. It uses a canvas as its background. When you 
capture an image or import an image, the size of canvas is the same as the size of the image. 
 
There are two modes for the canvas: standard mode and auto-stretch mode. By default, the canvas is in 
the auto-stretch mode in which the canvas changes its size as you add or move images and annotation 
objects. When you drag and drop an image into the window for image merge, the canvas will always adjust 
itself automatically. The canvas will be as large or as small as it is necessary to hold all objects. You don’t 
need to worry about the canvas size. You don’t even need to know what a canvas is. Just think it is a 
stretchable background. 
 
If you need to create an image with a fixed size, you would need the canvas to be in the standard mode. 
 
To set the canvas to the standard mode: 
 
1. Click the Canvas Properties command on Annotation Objects list to open the Canvas Properties 

dialog box. 
2. Uncheck the Auto Stretch Canvas option. 
 
You can set a fixed size based on your needs. 
 

 →  
 
When the canvas is in the standard mode, it displays three handles on the right edge, bottom edge and the 
lower right corner. By default, the handle is in green color. See screen shot below. You can change this 
color in Image Window Settings from the Options menu. See Chapter 3 for more information. 
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To change the canvas size by dragging: 
 

1. Select the Object Selection and Movement mode.   
2. Drag a handle on the right border, bottom border or at the lower right corner.  
 
You can use the New command from the File menu to generate an empty canvas. To set the initial canvas 
color, use the Image Window Settings command from the Options menu. 
 
9.2.2 Editing Modes 
 

 Hand Mode. Hand mode is a display mode. Under this mode, you can drag and drop the active 
image to a file. If the active is large, you can use this mode to drag the image up and down to view it. 
You can’t move annotation objects in this mode. 

 

 Object Selection and Movement Mode. This mode allows you to select, deselect, move, copy and 
delete any annotation object. Press this button and then click the object to select it. Click anywhere 
else to deselect an object. This mode also allows you to change the canvas size. 

Use this cursor to move an object: . Use this cursor to move the image: . 
 

 Group Selection Mode. This mode allows you to select, deselect, move, copy and delete multiple 
objects. Label alignment operations also require this mode. 

 

9.3 Draw and Callout Tools 
9.3.1 Drawing Tools 
 
All drawing tools are available on the first menu item. 
 
To use a drawing tool: 
 

1. Press the Draw button to open a drop-down menu.  
2. Select a tool from the menu. The mouse pointer becomes a crosshair.  
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3. Start drawing the shape or text on the image or canvas. 
 
9.3.2 Continuous Drawing Mode 
 
If you need to draw an object multiple times, hold down the CTRL key while you draw. FullShot will get 
into the continuous mode and the crosshair cursor will appear again after you finish a drawing. 
 
Not holding down the CTRL key while you draw is considered as single draw action. 
 
9.3.3 Drawing Bracket Objects 
 
There are two types of bracket objects: Curly Brackets and Square Brackets. Even though the icon on the 
drop-down menu shows one direction, they are all four directions enabled. 
 
Take the Curly Brackets as an example. The initial drawing gives you a bracket pointing to right. If you 
drag its handle and move to left, it will follow your move and points to left. When the horizontal dragging, 
left or right, produces a bracket with longer width than height, it becomes a horizontal bracket pointing to 
top or bottom. Again, dragging a horizontal bracket upward or downward produces a vertical bracket when 
its height is longer than its width. 
 

 
 
The Square Brackets work the same way. You can draw a square bracket pointing to any direction. 
 

 
 

9.3.4 Callout Tools 
 
Different from Drawing Tools, callout tools allow you to write something inside a callout object. 
 
To use a callout tool: 
 

1. Press the Callout button to open a drop-down menu.  
2. Select a callout style from the menu. The mouse pointer becomes a crosshair.  
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3. Start drawing the callout on the image or canvas. 
4. Type callout text inside the object. 
5. Drag its tail to point to the screen content you want to comment. 
 
See Chapter 9.5 to learn how to use labels. 
 
9.3.5 Callout Continuous Drawing Mode 
 
Same as the Drawing Tools, if you need to draw a callout object multiple times, hold down the CTRL key 
while you draw. FullShot will get into the continuous mode and the crosshair cursor will appear again after 
you complete a callout. 
 
Not holding down the CTRL key while you draw is considered as single draw action. 
 
9.3.6 Using Two Tails 
 
All callouts allow you to use at least one tail to point to what you want to annotate on an image; however, 
the first four callouts allow you to use two tails for extra annotation convenience. To enable the second tail, 
click and drag the second green dot inside of the callout object and extend it to any direction. The green is 
the default callout handle color and can be set to other colors in your FullShot settings. 

 

 
 
9.3.7 Object Popup Menu 
 
If you need to change object positions, delete an object, lock or unlock an object and set display properties, 
right click the object to pop up a menu. Choose a command you need to use accordingly. Read chapter 9.4 
to learn more about object commands. 
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9.3.8 Available Toolbar Buttons 
 
Use other commands from toolbars whenever necessary: 
 

 Undo command. Use this command to undo an action. 
 Redo command. Use this command to redo the previously undone action. 
 Line Width command. Use this command to select a line width. 
 Line End Style command. Use this command to select a line end style. 
 Font command. Use this command to select a font and style. Different from the font drop-down list, 

this command allows you to select font effects: stoke or underline. 
 Left Align Text command. 
 Center Align Text command. 
 Right Align Text command. 
 Top Align Text command. 
 Center Align Text command. This is for vertical alignment. 
 Bottom Align Text command. 

 
Fill Color, Line Color and Font Color commands have a pull-down menu respectively. Click the down-
arrow at the right to select a color. 
 

 
 
You can use gradient colors in all callout objects. To do so, select the first color from the first fill color 
drop-down menu and second color from the second fill color menu. Gradients will be applied 
automatically. 
 
To use single color callouts, select the same color for color 1 and color 2. 
 
Below are some callout samples. 
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9.3.9 Drag and Drop 
 
If you’d like to copy an object to another image window, you can drag and drop it by using the mouse: 
 
1. Click the object you’d like to copy. 
2. With the mouse button held down, drag the mouse pointer to another image window that you’d like to 

copy this object to. 
3. Release the mouse button inside the target image window where you’d like to place the object. 
 

If you are in the maximized window display mode, you will not see the target image window. In this case, 
you can drag the object onto the tab of the target window to trigger and bring the window on top, and then 
continue your drag and release the mouse button where you see fit on the target image. 
 

9.4 Annotation Objects List 
The original image and all annotation objects you added are listed on the Annotation Objects list. The list 
is an important tool that helps you select an object and move its layer position up or down by dragging. 
 
9.4.1 Object Layer 
 
Images, captured and imported, and annotation drawings are called objects in FullShot. Each and every 
object you see inside an image window is on a separate layer. Even though two annotation objects may not 
overlap each other, they are on different layers. 
 
A layer is assigned when an object is generated. If you don’t change layers, the layer sequence is the same 
as the order in which you generated those objects. 
 
In the sample below, there are one image object, one rectangular callout object and two vector drawing 
objects. The image object is at the bottom and is locked, which means that you can’t move the image 
object. To change object layer orders, drag an object and move the mouse pointer up and down the list. 
 

 
 
9.4.2 Object Locking 
 
When an object is locked, it means that you can’t select it and can’t move it by dragging. Normally, the 
image object is locked when you perform a capture or open an image file. 
 
To lock or unlock an object: 
 
1. Right click the object item on the Annotation Objects List or right click the object on the image.. 
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2. Choose the Toggle Lock command. 
The yellow lock image is displayed when an object is locked; the lock image is removed when the 
object is unlocked. 
 

9.4.3 Object Commands 
 

 Canvas Properties command. Use this command to set the current canvas settings. 

 Object Properties command. Use this command to change object opacity and drop-shadow settings. 

 Toggle Lock command. Use this command to lock or unlock an object. 

 Delete command. Use this command to delete one or more selected objects. 

 Clear All Objects command. Use this command to delete all annotation objects. This action is NOT 
undoable. 

 Merge to New Image command. Use this command to merge the image with all annotation objects to 
a new image window. 

 
9.4.4 Turn On/Off Object Drop Shadows 
 
1. Select the object on the Annotation Objects list. 
2. Choose the Object Properties command to open the property dialog box. 
3. Click the Settings column of the Enable row under the Drop Shadow section. 
4. Choose False to turn shadow off; choose True to turn it on. 
 

 

9.5 Using Labels 
 
To draw a single label: 
 

1. Press the Label button to open a drop-down menu.  

2. Select the One Label command.  The cursor becomes . 
3. Click anywhere on the image or canvas to draw a label. All labels are sequentially numbered. 
 
To draw multiple labels: 
 

1. Press the Label button to open a drop-down menu.  
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2. Select the Multiple Labels command.  The cursor becomes . 
 

 
 
3. Click anywhere on the image or canvas to draw a label. Repeat this action to draw more labels. 
4. To stop the Multiple Labels command, click the right mouse button anywhere or press Esc key on the 

keyboard. All labels are numbered sequentially. 
 
To change the starting number, label style and label size: 
 

1. Press the Label button to open a drop-down menu.  
2. Choose the Settings command to open the Label Settings dialog box. 
 

 
 
3. Change settings and click OK. 
 
If you want to change the default label size, starting number and label style, choose the Image Window 
Settings command from the Options menu. See Chapter 3.3 for details. 
 
To change the label fill color: 

1. Click the Group Selection command from the toolbar.  The cursor becomes a crosshair.  
2. Select one or more labels by dragging the crosshair cursor. 
3. Release the mouse button after the selection. 
4. Click Fill Color command to open its color menu. 
5. Select a color. 
6. The color will be applied to the selected labels. 
 
To change the label frame color: 

1. Click the Group Selection command from the toolbar.  The cursor becomes a crosshair.  
2. Select one or more labels by dragging the crosshair cursor. 
3. Release the mouse button after the selection. 
4. Click Line Color command to open its color menu. 
5. Select a color. 
6. The color will be applied to the selected labels. 
 
To change the label font color: 

1. Click the Group Selection command from the toolbar.  The cursor becomes a crosshair.  
2. Select one or more labels by dragging the crosshair cursor. 
3. Release the mouse button after the selection. 
4. Click Font Color command to open its color menu. 
5. Select a color. 
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6. The color will be applied to the selected labels. 
 
To align all labels with the top frame of an anchor label: 
 
1. Select one label as the anchor by clicking it. 

2. Press the Label button to open a drop-down menu.  
3. Choose the Top Anchor Align command.  
4. All labels will be aligned with the top frame of the anchor label. 
 
To align all labels with the left frame of an anchor label: 
 
1. Select one label as the anchor by clicking it. 

2. Press the Label button to open a drop-down menu.  
3. Choose the Left Anchor Align command.  
4. All labels will be aligned with the left frame of the anchor label. 
 
To align a group of labels with a top frame: 

1. Click the Group Selection command on the toolbar.  The cursor becomes a crosshair.  
2. Select labels you want to align by dragging the crosshair cursor. 
3. Release the mouse button after the selection. 

4. Press the Label button to open a drop-down menu.  
5. Choose the Top Group Align command.  
6. All selected labels will be aligned with the top frame of the label that has the lowest sequential 

number. 
 
To align a group of labels with a left frame: 
 

1. Click the Group Selection command on the toolbar.  The cursor becomes a crosshair.  
2. Select labels you want to align by dragging the crosshair cursor. 
3. Release the mouse button after the selection. 

4. Press the Label button to open a drop-down menu.  
5. Choose the Left Group Align command.  
6. All selected labels will be aligned with the left frame of the label that has the lowest sequential 

number. 
 

9.6 Converting Annotations to an Image 

Click Merge to New Image button  to convert the image along with all annotation objects to a new 
image. The new image will be displayed in a new window. You can save this image to any supported image 
file or copy it to the Clipboard. 
 

9.7 Saving Annotations in FSD 

You can save your creative work to a FSD (FullShot Document) file by clicking  button on the 
FullShot toolbar. Anyone who has FullShot can open this type of files and add new or modify existing 
annotated contents. 
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Chapter 10. Image Utilities 

10.1 Thumbnail Viewer 
 
Thumbnail Viewer is not available in the Standard Edition. 
 
You can use Thumbnail Viewer to display all of the images stored in a folder. 
 
To use the Thumbnail Viewer to view images in a folder: 
 

1. Select the folder in the FullShot Explorer. 
2. Click the Thumbnail Viewer button to open a dialog box. 
3. Set the row and column parameters. The maximum number of rows is 20. The maximum number of 

columns is 40. 
4. Click OK. 

 
You can right-click a folder name in the FullShot Explorer and launch the viewer directly. 
 

 →  →  
 

10.2 ImageExplorer 
 
ImageExplorer is not available in the Standard Edition. 
 
There are hundreds, even thousands, of images on your hard drives that you never realize taking so much 
disk space. When you surf on the net, your browser quietly gathers images and saves them to your hard 
drive for faster page jumping. Another amazing fact is that your Windows Explorer sometimes can't list all 
of those images. 
 
ImageExplorer can list, sort and display all of the images on your hard drives no matter where they are 
and how they got there. 
 

 To launch ImageExplorer, click the ImageExplorer button on the toolbar. 
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To sort images by Name, Size, Type, Modified Date or Location, click the correspondent column header. 
 
There are three sections in the status bar that is at the bottom of the ImageExplorer: 
 
1. The total number of image files listed in the ImageExplorer. 
2. The total hard drive space taken by the entire listed image files. 
3. The number of open windows. 
 

  Click Summary Report button to display image file statistics. 
 

10.3 Select Image Formats and Drives 
 
When you launch ImageExplorer, you will see a format selection dialog box. 
 

 
 
This dialog box lets you select image formats and drives on which you want ImageExplorer to scan and 
list. Different PCs may have a different number of drives. There are one floppy drive, two hard drives, two 
CD-ROM drives and one removable drive in the above example. By default, only hard drives and all of the 
supported image formats will be scanned. 
 

You can re-scan your PC at anytime by clicking the ImageExplorer icon on the toolbar.  
 

10.4 BatchCon 
 
BatchCon is not available in the Standard Edition. 
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BatchCon is a utility that can help you convert image files from one format to another easily. 
 
To launch BatchCon, click the BatchCon button on the toolbar. 
 

 →  
 
To convert image files to another format: 
 
1. Select an input directory. 
2. Select an input format or All Supported Formats. 
3. Select image files that you want to convert or click Select All to select all image files in the selected 

directory. 
4. Select an output directory. 
5. Select an output format. 
6. Click the Convert button. 
7. BatchCon will show you the conversion result in its list window. 

 
The above example shows that 18 files in C: directory are selected, converted to PNG format and 
successfully saved in C: directory. 
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Chapter 11. Export to Flash 
Flash is an animation format widely used on the web. It is a perfect way to show software demo and 
instructions. FullShot can generate Flash animation output. This feature is available only in the Enterprise 
Edition. 
 

11.1 Steps to Produce Flash Output 
 
1. Prepare screen shots. 
 Most of work you need to do is prepare screen shots or images. You need to get all images ready in 

this step. 
  
2. Add annotation objects.  
 You can add annotation objects onto your images and use them to tell your audience about your 

software features and how to use them. Every annotation object is displayed as a flash step that can be 
controlled by your audience when they click ‘Next’ or ‘Back’ button. 

 
3. Export to a Flash File. 
 

  →  
 
Adjust each image’s show sequence within the Flash file by click the up and down arrow buttons. Press the 
OK button after you have decided the order to select an output file. 
 

 
 
Flash uses SWF as the file extension. 
 

11.2 Play Flash Files 
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If you have a standalone Flash Player installed on your computer, double click the flash output filename to 
open it. If there is no standalone Flash player on your computer, you need to use a web browser to view it. 
For example, if you use the Internet Explorer, open it and then drag the Flash output file to the IE window. 
IE will start displaying the Flash step by step. 
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Chapter 12. Image Database 

12.1 What is an Image Database 
 
FullShot Image Database is available only in the Enterprise Edition. 
 
An image database is a collection of image records stored in database files. The FullShot Image Database 
is a proprietary database system that can help users manage a large amount of images. 
 
Local vs. Server Database In the FullShot’s terminology, a local database is a database that’s created on a 
user’s local hard drive.  A local database allows only one user to access the database. A server database is a 
SQL-based database that allows multiple users to access centralized data sources stored in the database. 
The database server is normally managed by an administrator. FullShot Enterprise Edition provides an 
embedded database engine that you can use to create a local image database easily. FullShot also contains 
necessary tools allowing users to establish a server database if you have a SQL database server. FullShot 
doesn’t bundle a SQL server in its offering. 
 
From Chapter 11 to 15, we describe methods about how to use the embedded local database. In the Chapter 
16, we’ll illustrate how to build a FullShot Image Database on a SQL server. 
 
A local database consists of four files: 
 
1. Data file with a filename extension .123 
2. Index file with a filename extension .321 
3. Master Keyword Table with a filename extension .kwd 
4. Keyword index file with a filename extension .kwi. 
 
All files are stored in the same directory. The sample database included with FullShot is a local database. It 
has four files: 
 
ImagePub.123 
ImagePub.321 
ImagePub.kwd 
ImagePub.kwi 
 
There is no limit on how large an image database can be. Your available hard drive space is the limit. 
 
To access a local database, you can use the following buttons on the toolbar. 
 

 Open Local Database command. Use this command to open a local image database. 

 Close Database command. Use this command to close the active database. 

 Thumbnail View command. When an image database is open, use this command to view images 
sequentially in the thumbnail mode. 

 New Record command. Use this command to create a new image record. 

 Add Record command. Use this command to add a newly created record into the active database. 

 Update Record command. Use this command to update the changed record into the active database. 
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 Fast Build command. Use this command to build a large amount of image files into the active 
database automatically. 

 Delete Record command. Use this command to remove a record from the active database. 

 Open Master Keyword Table command. Use this command to display all keywords for a database. 

 Select Keyword command. Use this command to open a keyword selection dialog box. 

 Add Image From Clipboard command. Use this command to copy an image from the Clipboard to 
the active record. 

 Add Image From File command. Use this command to copy an image from a file into the active 
record. 

 Delete Image command. Use this command to remove an image from the active record. 
 

12.2 Open a Local Image Database 

 
There are two ways to open a local image database. 
 

1. use the Open Database command from the toolbar. 
2. use the FullShot Explorer - Navigate the FullShot Explorer; find the database filename and single 

click on it. 
 

 →  
 
After the database is opened, the FullShot Explorer will be organized in folders. 
 
You can open only ONE DATABASE at a time. 
 

12.3 Information about an Image Database 
 
To display information about an image database, choose the Properties command from the Database menu. 
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 →  
 
If you want to change the creator or company name, click the Creator data field or the Company data 
field. In the example above, you should click Harry Houston or Image Publishing LLC. FullShot will 
display a dialog box for you to make changes. 
 

 
 
No other information can be changed. 
 

12.4 Image Database Record 
 
An image database record contains an image and information about the image. There are two folders in a 
record: the Record folder and the Image folder. There are several fields in that you can enter data about an 
image. In the sample database ImagePub.123, field1, field2, field3 and field4 are ID, Title, Subject and 
Description respectively. 
 
The record ID field is a required field. It is a numeric field. It must be unique. An ID can be assigned only 
to one record. When a record is deleted from the database, its record ID is available for reassignment. 
 
Field2 (Title) and Field3 (Subject) are also required fields. They may contain both numeric and alphabetic 
data. You must enter data into those fields before you can add a record into the active database. Field4, the 
Description field in the sample database, is not required. You can enter whatever into that field or leave it 
empty. 
 
Create Time and Update Time are displayed in the middle of a record. You may not change them. When 
you create a new record, the Create Time is recorded and saved; when you update a record, the Update 
Time is recorded and saved with the record. 
 
You can enter keywords for a record. There are four keywords assigned to this record. However, there is no 
limit on how many keywords you can use for a record. Since the Keyword field is not a required field, you 
don't have to use any keyword for a record. 
 
The Record Notepad and the Image Notepad use an unformatted field that you can put anything into it. 
When you see the black dots on the Record tab or the Image Tab, it means that there is memo in the 
notepad.  
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Choose the Notepad command from the View menu to open or close the notepad window. You may also 
drag the separator bar to open or close it. 
 

 →  
 
The Image Attributes are not editable fields. They are descriptions about the stored image. 
 
The Image folder can display the image in the normal pixel mode or the fit-to-window mode. 
 

 click Normal Pixel Size button to display it in the normal pixel mode. 

 click Fit-to-Window button to display it in the fit-to-window mode. 
 

 
 
There is no limit on how many image records you can open at a time. But the more records you open, the 
more memory FullShot will take to maintain all of the data and images. The minimum RAM requirement is 
32MB. 64MB or more is a big plus to view more images and records at the same time without drying up 
your system resources. 
 

12.5 Changing Record Field Names 
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ID, Title, Subject and Description are default field names assigned by FullShot to Field1, Field2, Field3 
and Field4 respectively. You can change them to something else to suit your needs. 
 
To change record field names: 
 
1. Pull down the Database menu. 
2. Choose the Properties command. 
3. Click the Display tab. 
4. Make changes. 
5. You can also select a field name that will be displayed on the record window title bar. By default this 

field is the ID field. 
6. Click OK. 

 

 →  
 

12.6 Viewing Images in the Thumbnail Mode 
 
To view images of an FullShot image database sequentially, use the thumbnail view feature. 
 
1. Click the Thumbnail View button on the toolbar. 
 

 →  
 

2. Set rows and columns of the thumbnail view mode accordingly. The more rows and columns you 
set, the smaller the thumbnail image windows are. 3x6 mode is used by default. 

3. Set a starting record ID. 

4. Click OK. 
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As you can see from the sample screen shot above, the FullShot image database thumbnail viewer uses data 
tips to provide information about an image record. You can double click an image thumbnail to load and 
display the entire record. 
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Chapter 13. Searching Database 

13.1 Database Indexes 
 
An Image database supports six indexes. When a database is opened, all six indexes are loaded and ready 
for search. 
 

 
 
Each index matches a record field. In the sample database, 
 
The ID index is the ID field. 
The Title index is the Title field. 
The Subject index is the Subject field. 
The Keyword index is the Keyword field. 
The Create index is the Create Time field. 
The Update index is the Update Time field. 
 
The Description, Image Attributes, Record Notepad and Image Notepad don’t have an index. 
 

13.2 Index Entry Normalization 
 
All index entries are normalized by FullShot internal standards. The basic rules used are as follows. 
 
Field1 (ID) index: leading zeros are added to make sorting and displaying easier. 
Create Date and Update Date indexes: use YYYY-MM-DD format. 
Field2 (Title), Field3 (Subject), and Keyword indexes: accept only 0-9, A-Z and space and convert them to 
upper cases. You can use special characters in those data fields, but FullShot will eliminate them when 
building indexes. This normalization rule makes sorting and searching straightforward. 
 

13.3 Data Tips 
 
FullShot image database uses data tips extensively for index entries. Stop the cursor on any index entry for 
a while, and FullShot will provide information on how many records contain the index entry. Since the ID 
index is a unique index and no two records can share the same ID, the data tip for the ID index entry is the 
content of the field2 and field3. In the sample database, the field2 is the Title field; and the field3 is the 
Subject field. 
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Here are some samples of data tips. 
 

     
 

13.4 Point-and-Click Searches 
 
A Point-and-Click search means that you move the mouse pointer over to an index entry and click on it to 
launch a search. This is the most intuitive way to perform a database search. You can do a point-and-click 
search on any index. Suppose that we are searching the sample database ImagePub.123. 
 
Click the Title index tab. 
Move the mouse pointer over to the RED LOG entry. 
Click the RED LOGO entry. 
 
Since there is only one record that has this index entry, the point-and-click search will load the record and 
display it immediately.  
 

 The blue open book icon means that one or more records containing the index entry are opened. 
 

 →  
 
If more than one record has the same index entry, the point-and-click search will display the search result in 
the Search folder for you to review. For example, let's search the Subject index and click on the BANNER 
entry. 
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 →  
 
Click a search result entry in the Search folder will load and display the record. As we mentioned in 
Chapter 2.5, you may use the left click to open a new record window and use the right click to replace the 
top record window or vice versa. 
 

13.5 Type-to-Locate Searches 
 
If you are searching a large database, the index may contain hundreds or thousands of entries. The point-
and-click search method may be inconvenient. The type-to-locate search method is an alternative to the 
point-and-click method. 
 
To perform a type-to-locate search: 
 

1. Click the index tab you want to search on. 
2. Type a letter. FullShot search engine will move the index list to the first entry that starts with what 

you typed. The entry will be highlighted. 
3. Repeat the step 2 until you see the entry you want. 
4. Press ENTER key to perform the search. 

 
FullShot will use the highlighted entry as the search term. No matter what you type, there is at least one 
entry to be highlighted. If only one record contains the index entry, the record will be opened and 
displayed. If more than one record has the index entry, the Search holder will be on top and the search 
result will be listed in the Search folder. 
 
You can use the type-to-locate search to any of the six indexes. In the example below, two letters F and O 
are typed in the Title index. If you hit the ENTER key, the FOXTAIL entry will be used as the search 
term. 
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You can use the star sign at the end of a type-to-locate search as the wildcard search operator. Any entry 
that starts with what you typed will be on the search result list. In the search example below, type FL* and 
then hit the ENTER key will get 5 records in the Search folder. 
 

   
 

13.6 Using Search Operators 
 
FullShot supports six search operators and two Boolean logic operators. We have already used the star sign 
as the wildcard operator in the previous section. Other operators are: 
 
> (greater than) 
>= (greater than and equal to) 
< (less than) 
<= (less than and equal to) 
 
= (equal to) is the default operator if you don't use any operator. Two Boolean operators are supported to 
connect two search criteria: 
 
& (and) 
| (or) 
 
Since FullShot uses the Type-to-Locate method for all of the six indexes, those operators can be used in 
the search typed in the Search folder only. The exact search format should be: 
 
INDEX NAME + SEARCH OPERATOR + SEARCH TERMS + BOOLEAN OPERATOR + 
SEARCH OPERATOR + SEARCH TERMS 
 
Do not type the '+' sign. It is used here to differentiate search components. The italic part is optional. 
 
Here are some searches performed in the sample database ImagePub.123. 
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For ID, Title and Subject indexes, you need to type the exact index name because those names can be 
changed. See Chapter 11.5 regarding how to change record field names. 
 
For Keyword, Create and Update indexes, you may use KW, CD and UD as abbreviation respectively. 
 

13.7 Changing Index Options 
 
By default, all six indexes are turned on so that the intuitive point-and-click search is available on all of the 
indexes. However, when the database is growing large, loading all indexes can be a time-consuming task. 
Plus, you may not need certain indexes like Create Date or Update Date. 
 
To change index options, 
 

1. Pull down the Database menu. 
2. Choose the Properties command. 
3. Click the Index tab. 
4. Set your options. 
5. Click OK. 

 

 →  
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Chapter 14. Building Database 

14.1 Creating a Local Database 
 
To create a new local database, 
 

1. Pull down the Database menu. 
2. Open the Local Database submenu. 
3. Choose the Create command. A dialog box will open. 
4. Select a folder and a filename. 
5. Enter the Creator and Company names. 
6. Click the Save button. 

 
You don't have to add .123 to the file extension. FullShot will do it for you automatically. 
 

 →  
 

14.2 Setting Database Options 
 
When a database is created, there is no record in it. Before you enter any record into the database manually 
or use the Fast Build feature to build multiple files into a database automatically, you may want to set the 
database build options so that FullShot can provide as much data as possible to reduce your typing 
workload. 
 
To set the database build options, 
 

1. Pull down the Database menu. 
2. Choose the Properties command. 
3. Click the Build tab. 
4. Set your options. 
5. Click OK. 
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 →  
 
The build options will decide how FullShot will provide information to Field2, Field3 and Field4 from an 
input filename. In the sample database, they are Title field, Subject field and Description field respectively. 
 

14.3 Using Master Keyword Table 
 
When a new database is created, FullShot automatically creates a Master Keyword Table. The master 
keyword table is designed to maintain a list of keywords that you use to index image records. It is used to 
generate a consistent keyword index. 

 

To view the master keyword table, click Master Keyword Table button on the toolbar. To enter a new 
keyword, right click and choose the New Keyword command. 
 

 →  
 
To change a keyword, choose the Properties command. To delete a keyword, choose the Delete Keyword 
command. 
 

 
 

14.4 Creating a New Record 
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To create a new record, click the New Record button on the toolbar. 
 

 →  
 
The record ID is provided by FullShot based on your last key in the active database. You can change the ID 
to any number as long as that number is not taken. 
 

14.5 Adding an Image to a Record 
 
To add an image to the new record, 
 

1. Click the Add Image button on the toolbar. 
2. Select the folder and the filename. 
3. Click the Open button. 

 

 →  
 
Title, Subject and Description will be provided by FullShot based on your settings in the database build 
options. No keyword is provided by default. 
 
You can use the FullShot Explorer to load an image to the active record: 
 

1. Navigate the FullShot Explorer and find the image filename. 
2. Hold down Ctrl key and click the image filename. 
3. The image will be loaded into the record. 
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14.6 Adding Keywords to a Record 
 
Since every image database has its own Master Keyword Table, you can select keywords from this table. 
To select keywords, click the Select Keyword button on the toolbar. 
 

 →  
 
But you don’t have to select keywords from the master keyword table. You can simply add any keyword to 
the record. The Master Keyword Table is only considered as a way to generate more consistent keyword 
index. To add a keyword to a record, type it in the edit box below the keyword list and then press ENTER 
or click the Add button. 
 

  
 
To change a keyword, click the keyword to select it. Click it again to open the edit box. Then you can make 
changes. 
 
To delete a keyword, click the keyword to select it and then press the DEL key. 
 

14.7 Writing Memos 
 
You can write memos in the Record Notepad and Image Notepad. To Open/Close the notepad, click the 
Notepad button on the toolbar or drag the separator bar. The limit for the notepad is 64KB. 
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14.8 Entering a New Record 
 

 
 
When you finish data entry on the record, click the Add Record button to enter it into the database. All 
indexes will be updated immediately. 
 

14.9 Using FastBuild 
 
If you need to add more than one image file into a database quickly, Fast Build is the best tool to perform 
this task. 
 
Click the Fast Build button on the toolbar to open the Fast Build dialog box. 
 

 →  
 
To Fast Build image files to the active database: 
 

1. Select an input folder. 
2. Select input files or click the Select All button to select all files under the input folder. 
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3. Click the Add button to add selected files to the fast build list. 
4. Repeat steps 1-3 to add more files to the fast build list. There is no limit on how many files you can 

build into a database at a time. 
5. Click a filename to preview it. 
6. Click the Build button to start the fast build process. 
7. Click the Close button to exit. 

 
When the Fast Build is completed, the fast build list will be cleared. 

 
To remove a file from the Fast Build list: 

 
1. Click the filename. 
2. Click the Remove button. 

 
To clear all of the files from the Fast Build list: 
 
Click the Clear All button. 
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Chapter 15. Record Operations 

15.1 Saving Record 
 
Sometimes you may want to move records from one database to another. Or you may want to send a record 
to your business associates. When you have such a need, you must save a record to a file. 
 
To save a record to a file: 
 

1. Pull down the File menu. 
2. Choose the Save Record command. 
3. Select a directory. 
4. Type a filename. 
5. Click the Save button. 

 
The record file has an extension .333. 
 

 →  
 

15.2 Saving Image 
 
To save the image of a record to a file: 
 

1. Click the Save Image button on the toolbar.  
2. Choose a folder, a filename and a file type. 
3. Click OK. 

 
Or 
 

1. Bring the Explorer folder on top. 
2. Click the image, hold down the mouse button and drag the image to the folder where you want to 

save the image. 
3. Release the mouse button when you see the folder is highlighted. 
4. Confirm the filename and the file type. 
5. Click OK. 
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15.3 Loading 
 
To load an image record: 
 

1. Open a database. 
2. Pull down the File menu. 
3. Choose the Open Record command. 
4. Navigate and find the file with extension .333. 
5. Click the Open button. 

 
Or you can open a record file using the FullShot Explorer. 
 

 
 
The opened record will adopt record field names of the active database. If you want to add the record into 
the database, make sure the record ID is unique. 
 

15.4 Updating 
 
To change a record, you need to do a search and display the record in the FullShot window. 
 
If you're updating a record, don't change its ID. Changing ID will generate a complete new record. You can 
change all of the editable fields. You cannot change the Image Attributes, Create Time and Update 
Time. 
 
To change an editable field, move the cursor to the field, delete the old data and then add new data. 
 
To change the image: 
 

1. Click the Image tab to make it on top. 

2. Clicking the Delete Image button to delete the current image.  

3. If you add the new image from the Clipboard, click the Add Image From Clipboard button.  

4. If you add the new image from a file, click the Add Image button.  
 
To change a keyword: 
 

1. Click the keyword to select it. 
2. Click it again to open the editing mode. 
3. Make changes. 
4. Press the ENTER key to complete the changes. 
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To remove a keyword: 
 
1. Click the keyword to select it. 
2. Press the Del key. 
 

 When you're done changing the active record, press the Update Record button to enter changes into 
the active database. All indexes will be updated immediately. 
 

15.5 Deleting 
 
To delete a record, you need to do a search and display the record in the FullShot window. 
 

 click the Delete Record button to delete the record. All index entries will be removed accordingly. 
 

15.6 Printing 
 
To print a record: 
 

1. Find and display the record. 
2. Pull down the File menu. 
3. Choose the Print Record command. 
4. Click OK. 

 

 →  
 
The image is printed on the left. All other data, including record notes and image notes is printed on the 
right. You can change the image size by clicking the Scaling spin buttons. 
 
Same as image printing, you can use a header and/or a footer for the record printing. 
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Chapter 16. Database Operations 

16.1 Backing Up 
 
Your image database is very important to you. Don't forget to back it up when you close it whether or not 
you have made changes to it. Making several backup copies is better than no backup. If you have an 
external drive, it's safer to back up your database on the external drive. Even though the image database 
engine has built-in routines to keep the data file in synch with the index file, disasters do happen and your 
file could be damaged or lost one way or another. 
 
If you want to make backup copies manually, make sure you back up all of the four files to a safe place. 
For example, to back up the sample database ImagePub.123, you need to copy the following four files to a 
drive that you think is safe. 
 
ImagePub.123 
ImagePub.321 
ImagePub.kwd 
ImagePub.kwi 
 
To back up a local database anytime, pull down the Database menu, choose the Local Database submenu 
and then choose the Backup command. 
 

 →   
 

16.2 Compacting 
 
If you have deleted records or updated your database by making changes, there will be wasted space in the database files. Use 
the Compact command from the Local Database menu to compact your database. The result database will be smaller. The 
original database will be renamed by adding OLD01 to its filename. You can delete it if you don't need it any more. 
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→  
 
The option Re-arrange Record IDs will re-assign record IDs to the new database based on its current IDs. 
If you have deleted records, the IDs of the deleted records will be given to other records. For example, 
suppose that you have a database of 10 records with IDs from 1 to 10; suppose that you have deleted 
records 3, 5 and 7. Compacting this database with the Re-arrange Record IDs checked will generate a 
new database with IDs of 1,2,3,4,5,6,7. 
 
For the sample database after the compacting process, there will be eight files listed under the directory: 
 
ImagePub.123 is the newly compacted data file. 
ImagePub.321 is the newly compacted index file. 
ImagePub.kwd is the newly compacted keyword data file. 
ImagePub.kwi is the newly compacted keyword index file. 
ImagePubOld01.123 is the original data file without compacting. 
ImagePubOld01.321 is the original index file without compacting. 
ImagePubOld01.kwd is the original keyword data file without compacting. 
ImagePubOld01.kwi is the original keyword index file without compacting. 
 
After testing your new database successfully, you may delete the original database. To play it safe, you 
may want to back it up for future reference. 
 

16.3 Merging 
 
Merging databases is a process to add all of the records of one database to another database. To merge local 
databases: 
 

1. Back up the first database before the merging process just in case something goes wrong. 

2. Open the first database by clicking the Open Database button.  
3. Pull down the Database menu and open Local Database submenu. 
4. Choose the Merge command. 
5. Select the second database for merging. 
6. Click OK. 

 
Be sure to back up the newly merged database. 
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→  
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Chapter 17. Server Database 

17.1 Server Side Setup 
 
FullShot software CD doesn’t have a SQL server, but contains all necessary code to help you build an 
image database on a SQL-based database server if you have one. The advantage is that you can share the 
image database on a network so that all of your colleagues can access and update the image database. 
Consult with your SQL server Database Administrator before you move forward. 
 
There are three steps to set up a FullShot image database on a SQL database server. 
 
Step 1: Create a database on the server. Every database server has procedures to create a database on the 
server. Consult with your Database Administrator to complete this step. 
 
Step 2: Create an ODBC Data Source on the server through the Control Panel. In fact, the FullShot 
Image Database doesn’t connect to your server directly, but connects to the ODBC Data Source instead. 
The ODBC Data Source name is the object that represents the database on your database server. In the 
example used in this book, a data source name called ImageBase is created. 
 
The ODBC data source setup is within the Control Panel. Open the Control Panel and open the ODBC 
(Data Source) icon and you will see the following screen. Again, our example is set up on Microsoft SQL 
Server. 
 

 
 
Step 3: run FullShot SQL database preparation code to establish all tables on your database. To do this, 
pull down the Database menu, open the Server Database submenu and choose the Prepares SQL 
Database command. The FullShot Image Database Setup wizard will open. 
 

 
 
The first window you see is for information only. It displays necessary steps you need to complete a 
database setup work. If you haven’t completed the step 1 and step2, click Cancel to stop. Otherwise, click 
OK to continue. 
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As we mentioned, the ImageBase is the data source that we have created in our example. The database 
server we used is Microsoft SQL Server. If you can’t find the data source name you have created, you 
probably didn’t do it right. Remember that you need to create a database on your server and then create a 
data source for the database you have created. 
 

 
 
The next screen is simple. You are asked to enter names to identify yourself and your company. 
 

 
 
And then a confirmation screen follows. 
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When you click Next button, FullShot will start preparing your database. 
 

 
 
Click the Finish button and your database setup is completed on the server side. You can create as many 
FullShot image databases as you want to on a server. You need to go through the same procedures to 
prepare each of them to make them ready on the server side. 
 

17.2 Client Side Setup 
 
Before a server image database can be accessed, you need to set up an ODBC Data Source on each client 
PC on which you plan to use the image database. You need to have the client access license to use the 
database server. Consult with your Database Administrator regarding the client license. 

 

The client side ODBC Data Source setup procedure is the same as the server side setup procedure. You 
need to do it in the Control Panel.  See section 16.1 for information. 
 

17.3 Using a Server Database 
 
Once the client side setup is completed, the image database is ready to use. To open a database, choose the 
Open command of the Server Database submenu. A dialog box will be open for you to select the data 
source that represents your image database. In our example, ImageBase is an available data source and it is 
a FullShot image database. 
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 →  
 
Once the database is open, all of the record level operations are the same as a local database. But the 
database level operations are different. Here are some issues you need to know. 
 
Database Backup: for a local database, FullShot provides backup function; for a server database, your 
database administrator should take care of the backup issue. Every database server has different backup 
procedures to follow. 
 
Database Compact: it is a database maintenance issue. For a local database, FullShot provides compact 
function; for a server database, every database server has certain rules to maintain a database. 
 
Database Merge: you can merge all records of a local database into a server database and all records of a 
server database into a local database. Merge is the only way to move all records off the server and back it 
up locally. 
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Chapter 18. Email 

18.1 About FullShot Email 
 
FullShot Email is available in the Enterprise Edition only. 
 
FullShot Email is not designed to replace your current email client software; however, it is designed to send 
out images quickly and easily without having to leave FullShot or save images to a file first. When you 
have an image database, local or server, you can send images out directly from the database and no need to 
check a record out. 
 
FullShot doesn’t provide functions of receiving email messages, but has all of the basic functions of 
sending messages. As a basic requirement, your PC must have connection to your ISP email server or 
corporate email server in order to use FullShot Email. To access the FullShot Email functions, you can use 
the following buttons on the toolbar. 
 

 New Message command. Use this command to create a new email message. 

 Attach File command. Use this command to attach files. 

 Send Message command. Use this command to send a message. 

 View Message Log command. Use this command to display all sent messages. 

 View Contact Database command. Use this command to display all contact records. 
 

18.2 Email Setup 
 
You need to set up your email connection before sending any message. To complete the setup requirement, 
choose the Email Setup command from the Email menu. 
 

 →  
 
Email Address: the email address you use to send messages. 
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Account Name: your email account name provided by your ISP or corporate email administrator. 
 
Password: the password for your email account. 
 
Incoming Mail Server Name: your ISP POP3 incoming email server name or your corporate email server 
name. 
 
Outgoing Mail Server Name: your ISP SMTP outgoing email server name or your corporate email server 
name. 
 

If you have any difficulty finding out what those required field values should be, consult with your ISP or 
your corporate email administrator. Another source of information about those fields is your Outlook 
Express email software that comes with your Windows. If you use this email client software, you can 
obtain email setup information by choosing Accounts command from the Tools menu. 
 
After setting up your connection data fields, you need to decide whether or not you want to keep an 
outgoing message log. FullShot has an embedded database designed to track all of the outgoing messages. 
The advantage is that you can remember what’s being sent out and who’s the recipient; the disadvantage is 
that it will take your storage space to hold sent messages and the storage space can be very large if you 
frequently attach images. If you want to keep a message log, choose the Keep Message Log command 
from the Email menu. A check sign in the front of this command means that the message log database is 
created. Choose this command again will remove the log permanently. 
 

 
 
 

18.3 Contact Database Setup 
FullShot Email has a built-in contact database. You can enter your contact information into this database. 
 
Step 1: choose the Create Contact Database command. 
Step 2: choose the New Contact command to enter contact data. 
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    →  
 

 Click the Contact Database button to view all contact records. 
 

18.4 Sending a Message 
 

 Click the New Message button to open a new message window. If you have an image window 
opened, it will be automatically attached. You can drag any image into the new message window as an 
attachment. If you need to attach any other files from your hard drive, click the Attach File button to attach 
them.  
 

   
 

 
 

 Click the Select Recipient button to select contact email addresses into To, Cc and Bcc fields. 

 Click the Send Message button to send the message. If you have already selected the Keep Message 
Log option, the sent message along with any attachment will be filed into the message log database. 
 

18.5 Message Log 
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 Click the Message Log button to list all of the sent messages. 
 

 
 
Right click the message log window to open a popup menu. You can open a message, delete a message or 
delete the entire message log. 
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Chapter 19. Troubleshooting 

19.1 Unsupported Image Files 
 
FullShot supports 18 image formats. It doesn't mean, however, that FullShot can open all of the files with 
the supported file extensions. If there is a file on your system that cannot be opened by FullShot, it is 
because FullShot doesn't understand how the image file is constructed. The best solution is to open this file 
by using the software that has created the file and then save it in a commonly used settings or options. 
 

19.2 Unable to Open an Image Database 
 
This problem happens only in the Enterprise Edition. 
 
Problem: 
 
You cannot open a local image database. The error message is 'Unable to Open the image database'. 
 
Possible Causes: 
 

1. The database's index file with the extension 321 is missing. 
2. Your Windows session was crashed for whatever reason. 
3. There was a power outage during a database update. 
4. A virus or something else has damaged your database files. 

 
Basic Knowledge: 
 
1. An image database has four files. For example, the sample database that is shipped with the software 

has the following files: 
 ImagePub.123 
 ImagePub.321 
 ImagePub.kwd 
 ImagePub.kwi 
 Together they make a complete image database. All files have to be stored in the same directory. 
2. Database directory means the directory where your database is stored. 
3. FullShot directory means the directory where the FullShot software is stored. This directory has 

FSHOT7.EXE and many DLL files. 
 
Solutions: 
 
Step 1: Check the directory where the database is stored and make sure both .123 and .321 files are there. If 
any of those two files is missing, the only way to get it back is copy your backups to the database 
directory. If you never back up your database, the database is no longer accessible. 
 
Step 2: If 123 and 321 files are both there, the problem could be caused by a crash. Exit FullShot. And then 
run FullShot and re-load the database. 
 
Step 3: If step1 and step2 can't solve the problem, your database must have been damaged. The only 
solution left is to copy your backup files back to the database directory. If you never back up your 
database, the database is no longer accessible. 
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Prevention: 
 
If you are serious about your image database, back it up everyday or after every successful session. 
FullShot has an automatic backup reminder, and all you need to do is click the Backup button. If you have 
an external drive, making extra backup copies on the external drive is highly recommended. 
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How To Order FullShot 
 
If you need to order FullShot licenses, visit www.inbit.com and click the Purchasing and Licensing link. It is 
on the first page and you can't miss it. Review the latest price sheet and licensing options. There are money 
saving volume packs available. 
 
Upgrade vs. Full Version 
 
Upgrade packages require a previously installed version on your PC or a valid license number from a 
previous version. If you have any version of FullShot version 1.xx to FullShot version 8.xx, the license key 
is printed on your program disk label or on the back of the CD jewel case or inside of the CD jacket. 
Upgrade packages will fail during installation if there is no qualified version on your drive. 
 
Standard Edition, Professional Edition and Enterprise Edition 
 
Make a decision on which version you need. The Standard Edition is the basic FullShot. The Professional 
Edition and the Enterprise Edition have a lot more features. For more information see Chapter 1. 
 
Credit Card Orders 
 
There is a secure web order system on the Inbit web site. Ordering FullShot on the web can guarantee that 
you get a license number immediately. No overnight shipping is needed. Your credit card number is 
processed in a secure manner so that even our internal sales reps have no way to see the number. 
 
Ordering on the web also has more options in terms of License Only and Full Package. So get on the web 
and check it out now. 
 
Purchase Order Policy 
 
For those of you who have to use corporate purchase orders, please fax your purchase orders to 1-408-730-
1756. Make sure to write the part number you are ordering on your purchase order with your billing and 
shipping addresses clearly marked. We accept purchase orders issued by U.S. corporations and 
organizations only. 
 
Mailing Address 
 
If you need to mail your purchase orders or checks directly to Inbit Sales Dept, please send them to 
 
Inbit Inc. 
P.O.Box 391674 
Mountain View, CA 94039 
USA 
 
How to Contact Inbit Inc. 
 
For technical questions, please email them to support@inbit.com. For sales questions, please email them to 
sales@inbit.com. Your questions will be answered within 24 hours. For any other inquiries, call 1-408-730-
9819. 
 


